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Powertrain Blockset Product Description
Model and simulate automotive powertrain systems

Powertrain Blockset provides fully assembled reference application models of automotive
powertrains, including gasoline, diesel, hybrid, and electric systems. It includes a
component library for simulating engine subsystems, transmission assemblies, traction
motors, battery packs, and controller models. Powertrain Blockset also includes a
dynamometer model for virtual testing. MDF file support provides a standards-based
interface to calibration tools for data import.

Powertrain Blockset provides a standard model architecture that can be reused
throughout the development process. You can use it for design tradeoff analysis and
component sizing, control parameter optimization, and hardware-in-the-loop testing. You
can customize models by parameterizing components in a reference application with your
own data or by replacing a subsystem with your own model.

Key Features
• Fully assembled models for gasoline, diesel, hybrid, and electric powertrains
• Libraries of engine, transmission, traction motor, and battery components
• Basic controllers for powertrain subsystems
• Standard drive cycle data, including FTP75, NEDC, and JC08
• Engine dynamometer model for virtual calibration and testing
• MDF file support for calibration data import

1 Getting Started
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Required and Recommended Products

Required Products
Powertrain Blockset product requires current versions of these products:

• MATLAB
• Simulink

Recommended Products
You can extend the capabilities of the Powertrain Blockset using the following
recommended products.

Goal Recommended Product
Model events Stateflow®
Use physical modeling blocks Simscape and Simscape™ add-ons
Optimize powertrain performance
and control parameters

Optimization Toolbox™

Generate reports MATLAB® Report Generator™

Simulink® Report Generator
Optimize powertrain design Simulink Design Optimization™
Parallel computing MATLAB Distributed Computing Server™

Parallel Computing Toolbox™
Calibrate engine models Model-Based Calibration Toolbox™

 Required and Recommended Products
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Getting Started with Powertrain Blockset
The Powertrain Blockset provides reference application projects assembled from blocks
and subsystems. Use the reference applications as a starting point to create your own
powertrain models.

Objective For See
Design tradeoff analysis and
component sizing, control
parameter optimization, or
hardware-in-the-loop (HIL)
testing.

Full conventional vehicle
with spark-ignition (SI) or
combustion-ignition (CI)

“Explore the Conventional
Vehicle Reference
Application” on page 3-4

Hybrid electric vehicle
(HEV) — Multimode

“Explore the Hybrid Electric
Vehicle Multimode
Reference Application” on
page 3-19

HEV — Input power-split “Explore the Hybrid Electric
Vehicle Input Power-Split
Reference Application” on
page 3-28

Full electric vehicle “Explore the Electric Vehicle
Reference Application” on
page 3-25

Engine and controller
calibration, validation, and
optimization before
integration with the vehicle
model.

CI engine plant and
controller

“Explore the CI Engine
Dynamometer Reference
Application” on page 3-9

SI engine plant and
controller

“Explore the SI Engine
Dynamometer Reference
Application” on page 3-14

This example shows how to run the conventional vehicle reference application and
examine the final drive gear ratio impact on fuel economy and tailpipe emissions.

Running this example requires a Stateflow license. You can install a Stateflow trial license
using the Add-On Explorer.

1 Open the conventional vehicle reference application project. By default, the
application has a 1.5–L spark-ignition (SI) engine and a final drive gear ratio of 3.

autoblkConVehStart 

1 Getting Started
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Project files open in a writable location.
2 Enable data logging for the fuel economy and tailpipe emissions signals.

a In the Visualization subsystem, select the FuelEconomy signal line and
Enable Data Logging.

b In the Visualization subsystem, enable data logging on the tailpipe emissions
signals.

 Getting Started with Powertrain Blockset
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c Save the SiCiPtReferenceApplication model.
3 Parameterize the final drive gear ratio.

a In the Passenger Car subsystem, navigate to the SiDrivetrain >
Differential and Compliance > Front Wheel Drive subsystem. Open
the Open Differential block.

b In the Open Differential block mask, change the Carrier to driveshaft ratio,
Ndiff parameter from 3 to the variable diffratio. the Carrier to driveshaft
ratio, Ndiff parameter represents the final drive gear ratio.

1 Getting Started
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Apply the change.

c In the Model Explorer, for the SiDrivetrain model, add the diffratio
parameter to the Model Workspace. Set the value to 3.

 Getting Started with Powertrain Blockset
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d Save the SIDrivetrain model.
4 Run a baseline conventional vehicle simulation with a final drive gear ratio of 3.

Import the results to the Simulation Data Inspector.

a In the Model Explorer, for the SiDrivetrain model, verify the Model
Workspace diffratio value is set to 3. If necessary, update the value and save
the SIDrivetrain model.

b In the SiCiPtReferenceApplication model, run the simulation for the
default run time.

c On the Simulink Editor toolbar, click the Simulation Data Inspector button

 to open the Simulation Data Inspector.

i In the Simulation Data Inspector, select Import. In the Import dialog box,
accept the defaults and select Import.

1 Getting Started
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ii In the Name field, enter diffratio=3.

5 Run a conventional vehicle simulation with a final drive gear ratio of 2. Import the
results to the Simulation Data Inspector.

a In the Model Explorer, for the SiDrivetrain model, set the Model Workspace
diffratio value to 2.

b Save the SIDrivetrain model.
c In the SiCiPtReference Application model, run the simulation for the

default run time.
d To import the results, on the toolbar, select the Simulation Data Inspector.

i In the Simulation Data Inspector, select Import. In the Import dialog box,
accept the defaults and select Import.

ii In the Simulation Data Inspector, in the Name field, enter diffratio=2.
6 Use the Simulation Data Inspector to explore the results. To assess the impact of the

final drive gear ratio on the fuel economy and tailpipe emissions, view the plots of the
simulation results. For example, these simulation results indicate a better powertrain
match when the final drive gear ratio is 2:

• Fuel economy increases when the final drive gear ratio changes from 3 to 2.
• Tailpipe emissions (HC, NOx, CO2) decrease when the final drive gear ratio

changes from 3 to 2.

 Getting Started with Powertrain Blockset

1-9



Next Steps
Assess the impact of the final drive gear ratio on vehicle performance. Although the fuel
economy and tailpipe emissions indicate a better powertrain match when the final drive
gear ratio is 2, the ratio also impacts performance.

To assess the vehicle performance, examine 0 to 100 km/hr acceleration times for each
axle setting. You can use the Drive Cycle Source block to output a constant velocity of
(100/3.6) m/s.

1 Getting Started
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See Also

Related Examples
• “Conventional Vehicle Fuel Economy and Emissions” on page 1-12

More About
• “Explore the Conventional Vehicle Reference Application” on page 3-4
• “Simulation Data Inspector in Your Workflow” (Simulink)

 See Also
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Conventional Vehicle Fuel Economy and Emissions
This example shows how to obtain the city and highway fuel economy and tailpipe
emissions for a conventional vehicle with a 1.5–L spark-ignition (SI) engine. To run this
example, install the city (FTP75) and highway (HWFET) drive cycles.

To open a script that executes these commands, in the MATLAB command window, type:

ConVehMPGExample 

1 Open the conventional vehicle reference application project.

autoblkConVehStart;
2 Prepare the reference application for simulation.

• Name the subsystems.

model = 'SiCiPtReferenceApplication';
dcs = [model, '/Drive Cycle Source'];
vis_sys = [model, '/Visualization'];

• Add signal loggers to the models using the function pt_set_logging.

pt_set_logging([vis_sys,'/Performance Calculations'],'US MPG',...
'Fuel Economy [mpg]','both')
pt_set_logging([vis_sys,'/Emission Calculations'],'TP HC Mass (g/mi)',...
'HC [g/mi]','both')
pt_set_logging([vis_sys,'/Emission Calculations'],'TP CO Mass (g/mi)',...
'CO [g/mi]','both')
pt_set_logging([vis_sys,'/Emission Calculations'],...
'TP NOx Mass (g/mi)','NOx [g/mi]','both')
pt_set_logging([vis_sys,'/Emission Calculations'],...
'TP CO2 Mass (g/km)','CO2 [g/km]','both')

3 Run a conventional vehicle simulation using the city drive cycle FTP75.

set_param(dcs,'cycleVar','FTP75');
tfinal = get_param(dcs, 'tfinal');
tf = tfinal(1:strfind(tfinal,' '));
simout1 = sim(model,'ReturnWorkspaceOutputs','on', 'StopTime', tf);

4 Run a conventional vehicle simulation using the highway drive cycle HWFET.

set_param(dcs,'cycleVar','HWFET');
tfinal = get_param(dcs, 'tfinal');

1 Getting Started
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tf = tfinal(1:strfind(tfinal,' '));
simout2 = sim(model,'ReturnWorkspaceOutputs','on', 'StopTime', tf);

5 Extract the city and highway fuel economy. Calculate a combined fuel economy.

logsout1 = simout1.get('logsout');
FE_urban = logsout1.get('Fuel Economy [mpg]').Values.Data(end);
logsout2 = simout2.get('logsout');
FE_hwy = logsout2.get('Fuel Economy [mpg]').Values.Data(end);

FE_combined = 0.55*FE_urban + 0.45*FE_hwy;
6 Extract the tailpipe emissions from the city drive cycle.

HC = logsout1.get('HC [g/mi]').Values.Data(end);
CO = logsout1.get('CO [g/mi]').Values.Data(end);
NOx = logsout1.get('NOx [g/mi]').Values.Data(end);
CO2 = logsout1.get('CO2 [g/km]').Values.Data(end);

7 Display the fuel economy and tailpipe emissions results in the command window.

fprintf('\n***********************\n')
fprintf('FUEL ECONOMY\n');
fprintf('   City:     %4.2f mpg\n', FE_urban);
fprintf('   Highway:  %4.2f mpg\n', FE_hwy);
fprintf('   Combined: %4.2f mpg\n', FE_combined);
fprintf('\nTAILPIPE EMISSIONS\n');
fprintf('   HC:   %4.3f [g/mi]\n',HC);
fprintf('   CO:   %4.3f [g/mi]\n',CO);
fprintf('   NOx:  %4.3f [g/mi]\n',NOx);
fprintf('   CO2:  %4.1f [g/km]\n',CO2);
fprintf('   NMOG: %4.3f [g/mi]',HC+NOx);
fprintf('\n***********************\n')

8 Remove the temporary variables.

clear ans dcs model tf tfinal vis_sys

Note You cannot pause simulations started using the sim command.

 Conventional Vehicle Fuel Economy and Emissions
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See Also

Related Examples
• “Install Drive Cycle Data” on page 5-2
• “Getting Started with Powertrain Blockset” on page 1-4

More About
• “Explore the Conventional Vehicle Reference Application” on page 3-4

1 Getting Started
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Workflows

• “SI Core Engine Air Mass Flow and Torque Production” on page 2-2
• “SI Engine Dual-Independent Cam Phaser Air Mass Flow Model” on page 2-5
• “SI Engine Speed-Density Air Mass Flow Model” on page 2-14
• “SI Engine Torque Structure Model” on page 2-17
• “SI Engine Simple Torque Model” on page 2-26
• “CI Core Engine Air Mass Flow and Torque Production” on page 2-27
• “CI Engine Speed-Density Air Mass Flow Model” on page 2-29
• “CI Engine Torque Structure Model” on page 2-33
• “CI Engine Simple Torque Model” on page 2-40
• “Engine Calibration Maps” on page 2-41
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SI Core Engine Air Mass Flow and Torque Production
A spark-ignition (SI) engine produces torque by controlling the net airflow into the engine
using throttle, turbocharger wastegate, and cam-phasing actuators.

While producing torque, the engine must comply with emission standards. To meet the
tailpipe emission standards, the ECU operates a three-way-catalyst (TWC) at the
stoichiometric air-fuel ratio (AFR).

In addition to emission controls, the ECU:

• Maximizes torque at middle speeds and high loads by operating rich of stoichiometry.
• Limits piston crown temperature at high speeds and high loads by running rich of

stoichiometry.

2 Workflows
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Air Mass Flow Models
To calculate engine air mass flow, configure the SI engine to use either of these air mass
flow models.

Air Mass Flow Model Description
“SI Engine Speed-Density Air
Mass Flow Model” on page 2-14

Uses the speed-density equation to calculate the
engine air mass flow, relating the engine air mass
flow to the intake manifold pressure and engine
speed. Consider using this air mass flow model in
engines with fixed valvetrain designs.

“SI Engine Dual-Independent Cam
Phaser Air Mass Flow Model” on
page 2-5

To calculate the engine air mass flow, the dual-
independent cam phaser model uses:

• Empirical calibration parameters developed from
engine mapping measurements

• Desktop calibration parameters derived from
engine computer-aided design (CAD) data

In contrast to typical embedded air mass flow
calculations based on direct air mass flow
measurement with an air mass flow (MAF) sensor,
this air mass flow model offers:

• Elimination of MAF sensors in dual cam-phased
valvetrain applications

• Reasonable accuracy with changes in altitude
• Semiphysical modeling approach
• Bounded behavior
• Suitable execution time for electronic control unit

(ECU) implementation
• Systematic development of a relatively small

number of calibration parameters

Torque Models
To calculate the brake torque, configure the SI engine to use either of these torque
models.

 SI Core Engine Air Mass Flow and Torque Production
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Brake Torque Model Description
“SI Engine Torque Structure
Model” on page 2-17

For the structured brake torque calculation, the SI
engine uses tables for the inner torque, friction
torque, optimal spark, spark efficiency, and lambda
efficiency.

“SI Engine Simple Torque Model”
on page 2-26

For the simple brake torque calculation, the SI
engine block uses a torque lookup table map that is
a function of engine speed and load.

See Also
SI Controller | SI Core Engine

More About
• “Engine Calibration Maps” on page 2-41
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SI Engine Dual-Independent Cam Phaser Air Mass Flow
Model

To calculate intake air mass flow for an engine equipped with cam phasers, you can
configure the spark-ignition (SI) engine with a dual-independent cam phaser intake air
mass flow model. As illustrated, the spark-ignition (SI) engine intake air mass flow
calculation consists of these steps:

• Collecting physical measurements
• Estimating the ideal trapped mass
• Correcting the trapped mass
• Calculating the intake air mass flow

The dual-independent cam phaser intake air mass flow model implements equations that
use these variables.

 SI Engine Dual-Independent Cam Phaser Air Mass Flow Model
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Mtrapped

Estimated ideal trapped mass

TM
corr

Trapped mass correction multiplier

TM flow

Flow rate equivalent to corrected trapped mass at the current engine speed

&mintkideal

Engine intake air mass flow at arbitrary cam phaser angles

&mintkideal

Engine intake port mass flow at arbitrary cam phaser angles

&m
air

Engine intake air mass flow final correction at steady-state cam phaser
angles

&mintk

Engine intake port mass flow at steady-state cam phaser angles

yintk,air

Engine intake manifold air mass fraction

MAPIVC

Intake manifold pressure at IVC

MATIVC

Intake manifold temperature at IVC

M
Nom

Nominal engine cylinder intake air mass at standard temperature and
pressure, piston at bottom dead center (BDC) maximum volume

IAT
Intake air temperature

N
Engine speed

Ncyl

Number of engine cylinders

VIVC

Cylinder volume at IVC

V
d

Displaced volume

R
air

Ideal gas constant

PAmb

Ambient pressure

T
std

Standard temperature

P
std

Standard pressure
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r
norm

Normalized density

jICP

Measured intake cam phaser angle

jECP

Exhaust cam phaser angle

L
ideal

Engine load (normalized cylinder air mass) at arbitrary cam phaser angles,
uncorrected for final steady-state cam phaser angles

L
Engine load (normalized cylinder air mass) at arbitrary cam phaser angles,
corrected for final steady-state cam phaser angles

Cps
Crankshaft revolutions per power stroke

fVivc

Cylinder volume at IVC table

fTMcorr

Trapped mass correction table

fairideal

Intake air mass flow table

faircorr

Intake air mass flow correction table

Collect Physical Measurements
In the SI engine model, the dual-independent cam phaser intake air mass flow model
requires these physical measurements:

• Intake manifold temperature and pressure at intake valve closing (IVC) condition
• Intake cam phase angle
• Exhaust cam phase angle
• Engine speed
• Ambient pressure and temperature
• Intake air mass flow, from one or more of the following

• Tank air meter
• Wide range air-fuel sensor and fuel-flow meter
• Wide range air-fuel sensor and injector pulse-width
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Estimate Ideal Trapped Mass
The dual-independent cam phaser intake air mass flow model uses the Ideal Gas Law to
estimate the ideal trapped mass at intake manifold conditions. The calculation assumes
the cylinder pressure and temperature at IVC equal the intake manifold pressure and
temperature.

M
MAP V

R MAT
trapped

IVC IVC

air IVC

@

For engines with variable intake cam phasing, the trapped volume at IVC varies.

The cylinder volume at intake valve close table (IVC), fVivc  is a function of the intake cam
phaser angle

V fIVC Vivc ICP= ( )j

where:

•
VIVC  is cylinder volume at IVC, in L.

•
jICP  is intake cam phaser angle, in crank advance degrees.
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Correct Trapped Mass
The dual-independent cam phaser intake air mass flow model uses a correction factor to
account for the difference between the ideal trapped mass in the cylinder and the actual
trapped mass. The trapped mass correction factor is a lookup table that is a function of
the normalized density and engine speed.

rnorm
IVC

Amb IVC

MAP IAT

P MAT
=

The trapped mass correction factor table, fTMcorr , is a function of the normalized density
and engine speed

TM f Ncorr TMcorr norm= (   ),r

where:

•
TM

corr , is trapped mass correction multiplier, dimensionless.
•

r
norm

 is normalized density, dimensionless.
• N is engine speed, in rpm.

 SI Engine Dual-Independent Cam Phaser Air Mass Flow Model
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• Normalized density accounts for the throttle position independent of a given altitude.
• Engine speed accounts for the pulsation effects of the piston movement.
• Ambient pressure is measured by a sensor on the electronic control unit (ECU) or

estimated using an inverse throttle valve model.
• The ECU estimates or measures intake air temperature (IAT) upstream of the throttle.

Trapped mass flow is expressed as a flow rate in grams per second (g/s). The trapped
mass flow is the maximum gas mass flow through the engine when no residual gases
remain in the cylinder at the end of the exhaust stroke.

TM

g

kg
N TM M N

s

min
Cps

flow

cyl corr trapped

=

Ê

Ë
Á

ˆ

¯
˜

Ê
Ë
Á

ˆ
¯
˜

1000

60

Calculate Air Mass Flow
To determine the engine intake air mass flow at arbitrary cam phase angles, the dual-
independent cam phaser air mass flow model uses a lookup table.

The phaser intake mass flow model lookup table is a function of exhaust cam phaser
angles and trapped air mass flow

&m f TMintkideal intkideal ECP flow= ( , )j

where:

•
&mintkideal  is engine intake port mass flow at arbitrary cam phaser angles, in g/s.

•
jECP  is exhaust cam phaser angle, in degrees crank retard.

•
TM flow  is flow rate equivalent to corrected trapped mass at the current engine speed,
in g/s.
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• The exhaust cam phasing has a significant effect on the fraction of burned gas. During
the exhaust stroke, exhaust cam-phasing affects the exhaust valve position at exhaust
valve closing (EVC) relative to the piston position. A retarded (late) exhaust cam phase
angle moves EVC past piston top dead center (TDC), causing the exhaust gas to flow
back from the manifold runner into the cylinder. This pull-back triggers the reburn of
crevice volume gasses, reducing nitric oxide and nitrogen dioxide emissions (NOx) via
charge temperature reduction and hydrocarbon (HC) emissions. Exhaust temperature
and back pressure affect exhaust gas back-flow and exhaust cam phaser timing.
Exhaust gas temperature and pressure correlate to trapped mass flow. Since at least
80% of trapped mass flow is unburned air, air mass flow is highly correlated to trapped
mass flow.

• The unburned air mass flow determines the engine load and open-loop fuel control to
achieve a target air-fuel ratio (AFR).

• The lookup table allows arbitrary cam phaser position combinations that can occur
during transient engine operations when the phasers are moving from one target
position to another.

The intake air mass flow correction lookup table, faircorr , is a function of ideal load and
engine speed

& &m m f L Nair intkideal aircorr ideal= ( , )

where:
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•
L

ideal  is engine load (normalized cylinder air mass) at arbitrary cam phaser angles,
uncorrected for final steady-state cam phaser angles, dimensionless.

• N is engine speed, in rpm.
•

&m
air  is engine intake air mass flow final correction at steady-state cam phaser angles,

in g/s.
•

&mintkideal  is engine intake port mass flow at arbitrary cam phaser angles, in g/s.

• To calculate the engine intake port mass flow, the engine model uses this equation.

&
&

m
m

y
intk

air

intk,air

=

• Ideal load is the normalized engine cylinder unburned intake air mass before the final
correction. To calculate ideal load, the model divides the unburned intake air mass by
the nominal cylinder intake air mass. The nominal cylinder intake air mass is the
intake air mass (kg) in a cylinder at piston bottom dead center (BDC) with air at
standard temperature and pressure:
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• The final engine load is expressed by

L

s
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See Also
SI Controller | SI Core Engine

More About
• “SI Core Engine Air Mass Flow and Torque Production” on page 2-2
• “SI Engine Speed-Density Air Mass Flow Model” on page 2-14
• “Engine Calibration Maps” on page 2-41
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SI Engine Speed-Density Air Mass Flow Model
To calculate the air mass flow in the spark-ignition (SI) engine, you can configure the
Spark Ignition Core Engine block to use a speed-density air mass flow model. The speed-
density model uses the speed-density equation to calculate the engine air mass flow. The
equation relates the engine air mass flow to the intake manifold gas pressure, intake
manifold gas temperature, and engine speed. Consider using this air mass flow model in
simple conventional engine designs, where variable valvetrain technologies are not in
use.

To determine the air mass flow, the speed-density air mass flow model applies these
speed-density equations at the intake manifold gas pressure and gas temperature states.

&

& &

m

MAPV N
min

s

CpsR MAT

m my

intk

d

air
v

air inintk,air

=

È

ÎÍ
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˚̇

=

1

60

 

h

ttk

The speed-density air mass flow model uses a volumetric efficiency lookup table to correct
the ideal air mass flow.
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The engine volumetric efficiency lookup table, f
vh , is a function of intake manifold

absolute pressure and engine speed

h hv f MAP N
v

= ( , )

where:

•
h

v
 is engine volumetric efficiency, dimensionless.

• MAP is intake manifold absolute pressure, in KPa.
• N is engine speed, in rpm.

To develop the volumetric efficiency table, use the measured air mass flow rate, intake
manifold gas pressure, intake manifold gas temperature, and engine speed from engine
performance testing.

hv
air

d

air

CpsR MAT

MAPV N
min

s

m=
È

ÎÍ
˘

˚̇

1

60

 
&

The air mass flow model implements equations that use these variables.
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MAP
Cycle average intake manifold pressure

&mintk

Engine intake port mass flow

&m
air

Engine intake air mass flow

V
d

Displaced volume

N Engine speed

Cps
Crankshaft revolutions per power stroke

MAT
Cycle average intake manifold gas absolute temperature

R
air

Ideal gas constant for air and burned gas mixture

f
vh

Engine volumetric efficiency lookup table

h
v

Engine volumetric efficiency

References
[1] Heywood, John B. Internal Combustion Engine Fundamentals. New York: McGraw-Hill,
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SI Engine Torque Structure Model
The spark-ignition (SI) engine implements a simplified version of the SI engine torque
structure calculation used in a Bosch Engine Management System (EMS). For the torque
structure estimation calculation, the block requires calibration tables for:

• Inner torque — Maximum torque potential of the engine at a given speed and load
• Friction torque — Torque losses due to friction
• Optimal spark — Spark advance for optimal inner torque
• Spark efficiency — Torque loss due to spark retard from optimal
• Lambda efficiency — Torque loss due to lambda change from optimal
• Pumping torque — Torque loss due to pumping

The tables available with Powertrain Blockset were developed with the Model-Based
Calibration Toolbox.

 SI Engine Torque Structure Model
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Lookup Table Used to Determine Plot
Inner torque,

fTqinr

Tq f L Ninr Tqinr= ( , ) The inner torque lookup table, fTqinr , is a
function of engine speed and engine load,

Tq f L Ninr Tqinr= ( , ) , where:

•
Tqinr  is inner torque based on gross
indicated mean effective pressure, in N.m.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.
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Lookup Table Used to Determine Plot
Friction torque,

fTfric

T f L,Nfric Tfric= ( ) The friction torque lookup table, fTfric , is a
function of engine speed and engine load,

T f L,Nfric Tfric= ( ) , where:

•
Tfric  is friction torque offset to inner
torque, in N.m.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.

 SI Engine Torque Structure Model
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Lookup Table Used to Determine Plot
Pumping torque,
ƒTpump

Tpump=ƒTpump(L,N) The pumping torque lookup table, ƒTpump, is a
function of engine speed and injected fuel
mass, Tpump=ƒTpump(L,N), where:

• Tpump is pumping torque, in N.m.
• L is engine load, as a normalized cylinder

air mass, dimensionless.
• N is engine speed, in rpm.
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Lookup Table Used to Determine Plot
Optimal spark,

fSAopt

SA f L Nopt SAopt= ( , ) The optimal spark lookup table, fSAopt , is a
function of engine speed and engine load,

SA f L Nopt SAopt= ( , ) , where:

• SAopt is optimal spark advance timing for
maximum inner torque at stoichiometric air-
fuel ratio (AFR), in deg.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.

 SI Engine Torque Structure Model
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Lookup Table Used to Determine Plot
Spark efficiency,

fMsa
M f SA

SA SA SA

sa Msa

opt

=

= -

( )D

D

The spark efficiency lookup table, fMsa , is a
function of the spark retard from optimal

M f SA

SA SA SA

sa Msa

opt

=

= -

( )D

D

where:

•
M

sa  is the spark retard efficiency
multiplier, dimensionless.

•
DSA is the spark retard timing distance
from optimal spark advance, in deg.
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Lookup Table Used to Determine Plot
Lambda

efficiency, fMl

M fMl l l= ( ) The lambda efficiency lookup table, fMl , is a

function of lambda, M fMl l l= ( ) , where:

•
Ml  is the lambda multiplier on inner
torque to account for the air-fuel ratio
(AFR) effect, dimensionless.

•
l  is lambda, AFR normalized to
stoichiometric fuel AFR, dimensionless.

The engine brake torque is a based on inner torque with lambda efficiency, spark retard
efficiency multipliers, pumping torque, and a friction torque offset

T M M Tq T Tbrake sa inr fric pump= - -l

To account for thermal effects, the torque structure model corrects the friction torque
calculation as a function of coolant temperature.
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T M f L N

M f T

fric fric Tfric

fric fric temp coolant

=

=

( , )

( ),

The pumping torque is a function of engine speed and engine speed.

T f L Npump Tpump= ( , )

SAopt

Optimal spark advance timing for maximum inner torque at stoichiometric
air-fuel ratio (AFR)

DSA
Spark retard timing distance from optimal spark advance

SA
Spark advance timing

L
Engine load at arbitrary cam phaser angles, corrected for final steady-state
cam phaser angles

N Engine speed

Ml

Lambda multiplier on inner torque to account for the AFR effect

l
Lambda, AFR normalized to stoichiometric fuel AFR

M
sa

Spark retard efficiency multiplier

fMsa

Spark efficiency lookup table to account for torque loss due to spark retard
from optimal

fTfric

Friction torque lookup table to account for torque losses due to friction

fMl

Lambda efficiency lookup table to account for torque loss due to lambda
change from optimal

fSAopt

Optimal spark lookup table, for maximum inner torque as a function of
engine speed and load

fTqinr

Inner torque lookup table, for maximum torque potential of the engine at a
given speed and load

Tbrake

Engine brake torque after accounting for spark advance, AFR, and friction
effects

Tfric

Friction torque offset to inner torque
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Tqinr

Inner torque based on gross indicated mean effective pressure

Tpump Pumping torque
Mfric Friction torque modifier
Tcoolant Coolant temperature

References
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SI Engine Simple Torque Model
For the simple torque lookup table model, the SI engine uses a lookup table map that is a

function of engine speed and load, T f L Nbrake TnL= ( , ) , where:

•
Tbrake  is engine brake torque after accounting for spark advance, AFR, and friction
effects, in N.m.

• L is engine load, as a normalized cylinder air mass, dimensionless.
• N is engine speed, in rpm.

See Also
SI Controller | SI Core Engine

More About
• “SI Core Engine Air Mass Flow and Torque Production” on page 2-2
• “SI Engine Torque Structure Model” on page 2-17
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CI Core Engine Air Mass Flow and Torque Production
A compression-ignition (CI) engine produces mechanical power by injecting fuel into the
combustion chamber near the end of the compression stroke. Since the combustion
chamber pressure and temperature exceeds the fuel ignition limit, spontaneous ignition
occurs after injection. Heat released during combustion increases the cylinder pressure.
During the power stroke, the engine converts the pressure to mechanical torque.

Torque production relates to both the injected fuel mass and injection timing. CI engines
operate at lean air-fuel ratio (AFR) conditions, so the AFR is greater than the
stoichiometric AFR. CI engines use exhaust gas recirculation (EGR). The exhaust gases
recirculate back to the intake manifold, reducing engine-out nitric oxide and nitrogen
dioxide (NOx) emissions.

Air Mass Flow
To calculate the air mass flow, the compression-ignition (CI) engine uses the “CI Engine
Speed-Density Air Mass Flow Model” on page 2-29. The speed-density model uses the
speed-density equation to calculate the engine air mass flow, relating the engine intake
port mass flow to the intake manifold pressure, intake manifold temperature, and engine
speed.

Torque
To calculate the engine torque, you can configure the CI controller to use either of these
torque models.

Brake Torque Model Description
“CI Engine Torque Structure
Model” on page 2-33

Model accounts for the reduction in engine torque as
these engine conditions vary from nominal:

• Fuel injection timing
• Intake manifold gas temperature and pressure
• Unburned cylinder air mass

“CI Engine Simple Torque Model”
on page 2-40

For the simple engine torque calculation, the CI
engine uses a torque lookup table map that is a
function of engine speed and injected fuel mass.
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CI Engine Speed-Density Air Mass Flow Model
To calculate the air mass flow in the compression-ignition (CI) engine, the CI Core Engine
block uses a speed-density air mass flow model. The speed-density model uses the speed-
density equation to calculate the engine air mass flow. The equation relates the engine air
mass flow to the intake manifold gas pressure, intake manifold gas temperature, and
engine speed. In the CI Core Engine block, the air mass flow and the cylinder air mass
determine the engine load.

To determine the air mass flow, the speed-density air mass flow model uses this speed-
density equation at the intake manifold and the volumetric efficiency. The model subtracts
the exhaust gas recirculation (EGR) burned gas from the mass flow at the intake port.

&

& & &

m

MAPV N
min

s

CpsR MAT

m m m

port

d

air
v

air port egr

=

È

ÎÍ
˘

˚̇

= -

1

60

 

h

The speed-density air mass flow model uses a volumetric efficiency lookup table to
determine the volumetric efficiency.

The volumetric efficiency lookup table is a function of the intake manifold absolute
pressure at intake valve closing (IVC) and engine speed
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h hv f MAP N
v

= ( , )

where:

•
h

v
 is engine volumetric efficiency, dimensionless.

• MAP is intake manifold absolute pressure, in KPa.
• N is engine speed, in rpm.

To create the volumetric efficiency table, use the air mass flow rate from measured engine
performance data and the speed-density equation.
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To calculate the engine load, the block divides the calculated unburned air mass by the
nominal cylinder air mass. The nominal cylinder air mass is the mass of air (in kg) in a
cylinder with the piston at bottom dead center (BDC), at standard air temperature and
pressure.
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cyl air std
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The model implements equations that use these variables.

&m
air

Engine air mass flow

MAP
Cycle average intake manifold pressure

&mport

Total engine air mass flow at intake ports, including EGR flow

&megr

Recirculated burned gas mass flow entering engine intake port

V
d

Displaced volume

N Engine speed

Cps
Crankshaft revolutions per power stroke

R
air

Ideal gas constant for air and burned gas mixture

MAT
Cycle average intake manifold gas absolute temperature

h
v

Engine volumetric efficiency

f
vh

Engine volumetric efficiency lookup table

L Engine load (normalized cylinder air mass) at arbitrary cam phaser angles,
corrected for final steady-state cam phaser angles

M
Nom

Nominal engine cylinder air mass at standard temperature and pressure;
piston at bottom dead center (BDC) maximum volume

P
std

Standard pressure

T
std

Standard temperature
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CI Engine Torque Structure Model
The CI core engine torque structure model determines the brake engine torque by
reducing the maximum engine torque potential as these engine conditions vary from
nominal:

• Fuel injection timing
• Intake manifold gas temperature and pressure
• Unburned cylinder air mass

The engine brake torque is a based on the inner torque and friction torque.

T Tq T Tbrake inr fric pump= - -

The nominal inner torque is derived from the gross mean effective pressure (GMEP) and
piston area at nominal engine calibration settings. The inner torque is calculated by
modifying the nominal inner torque via a series of multiplicative modifiers for main
injection timing, intake manifold gas temperature, intake manifold gas pressure, and
unburned cylinder air mass. The torque structure model uses lookup tables to determine
the modifiers.

Tq Tmod Tmod Tmod TmodTqinr mainsoi map mat apcinrnom=

The unburned cylinder air mass per cylinder (APC) calculation corrects the inner torque
as the cylinder air mass varies from nominal conditions. The APC is a function of engine
air mass flow rate and engine speed.
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To account for thermal effects, the torque structure model corrects the friction torque
calculation as a function of coolant temperature.

T M f F N

M f T

fric fric Tfric

fric fric temp coolant

=

=

( , )

( ),

The pumping torque is a function of engine speed and injected fuel mass.
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T f F Npump Tpump= ( , )

The model implements equations that use these variables.

Tfric

Friction torque offset to inner torque

Tqinr

Inner torque, based on modified nominal inner torque

Tqinrnom Inner torque at nominal engine calibration settings

Tbrake

Engine brake torque after accounting for spark advance, AFR, and
friction effects

Tpump Pumping torque
Mfric Friction torque modifier
Tcoolant Coolant temperature
F Injected fuel mass
Tmodmainsoi Torque modifier due to MAINSOI torque loss
MAINSOI Main start-of-injection timing
Tmodmat Torque modifier due to MAT torque loss.
MAT Intake manifold absolute pressure
Tmodmap Torque modifier due to MAP torque loss
MAP Intake manifold absolute pressure
Tmodapc Torque modifier due to APC torque loss
APC Unburned air per engine cylinder

Cps
Crankshaft revolutions per power stroke, rev/stroke

N Engine speed

Ncyl

Number of engine cylinders

&mintk

Engine air mass flow

The tables available with Powertrain Blockset were developed using the Model-Based
Calibration Toolbox.

2 Workflows

2-34



The inner torque lookup table, fTqinr , is a function of engine speed and injected fuel

mass, Tq f F Ninr Tqinr= ( , ) , where:

•
Tqinr  is inner torque based on gross indicated mean effective pressure, in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

The pumping torque lookup table, ƒTpump, is a function of engine speed and injected fuel
mass, Tpump=ƒTpump(F,N), where:

• Tpump is pumping torque, in N.m.
• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.
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The friction torque lookup table, fTfric , is a function of engine speed and injected fuel

mass, T f F,Nfric Tfric= ( ) , where:

•
Tfric  is friction torque offset to inner torque, in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

The main start-of-injection (MAINSOI) torque modifier lookup table is a function of

MAINSOI and engine speed Tmod f MAINSOI, Nmainsoi mainsoi= ( ) , where:

• Tmodmainsoi is the torque modifier due to MAINSOI torque loss.
• MAINSOI is the main start-of-injection timing, in degrees crank angle after top dead

center (degATDC).
• N is engine speed, in rpm.
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The intake manifold absolute pressure (MAP) torque modifier lookup table is a function of

MAP and engine speed, Tmod f MAP,Nmap map= ( ) , where:

• Tmodmap is the torque modifier due to MAP torque loss.
• MAP is the measured intake manifold absolute pressure, in kPa.
• N is engine speed, in rpm.

The intake manifold gas temperature (MAT) torque modifier lookup table is a function of

MAT and engine speed, Tmod f MAT,Nmat mat= ( ) , where:

• Tmodmat is the torque modifier due to MAT torque loss.
• MAT is the measured intake manifold gas pressure, in C.
• N is engine speed, in rpm.
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The unburned air per cylinder (APC) torque modifier lookup table is a function of APC and

engine speed, Tmod f APC,Napc apc= ( ) , where:

• Tmodapc is the torque modifier due to APC torque loss.
• APC is the unburned air per cylinder, in mg.
• N is engine speed, in rpm.
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Control. VDI Fortschrittsberichte, 8. VDI Verlag , Düsseldorf, 2013.
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See Also
CI Controller | CI Core Engine

More About
• “CI Core Engine Air Mass Flow and Torque Production” on page 2-27
• “CI Engine Simple Torque Model” on page 2-40
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CI Engine Simple Torque Model
For the simple torque lookup table model, the CI engine uses a lookup table is a function

of engine speed and injected fuel mass, T f F Nbrake Tnf= ( , ) , where:

• Tq = Tbrake is engine brake torque after accounting for engine mechanical and
pumping friction effects, in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

See Also
CI Controller | CI Core Engine

More About
• “CI Core Engine Air Mass Flow and Torque Production” on page 2-27
• “CI Engine Torque Structure Model” on page 2-33
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Engine Calibration Maps
Calibration maps are a key part of the engine plant and controller models available in the
Powertrain Blockset. Engine models use the maps to represent engine behavior and to
store optimal control parameters. Using calibration maps in control design leads to
flexible, efficient control algorithms and estimators that are suitable for electronic control
unit (ECU) implementation.

To develop the calibration maps for engine plant and controller models in the reference
applications, MathWorks® developed and used processes to measure performance data
from 1.5–L spark-ignition (SI) and compression-ignition (CI) engine models provided by
Gamma Technologies LLC.

To represent the behavior of engine plants and controllers specific to your application,
you can develop your own engine calibration maps. The data required for calibration
typically comes from engine dynamometer tests or engine hardware design models.

Engine Plant Calibration Maps
The engine plant model calibration maps in the Powertrain Blockset SI and CI reference
applications affect the engine response to control inputs (for example, spark timing,
throttle position, and cam phasing).

To develop the calibration maps in the Powertrain Blockset engine plant models,
MathWorks used GT-POWER models from the GT-SUITE modeling library in a Simulink-
based virtual dynamometer. MathWorks used the Model-Based Calibration Toolbox to
create design-of-experiment (DoE) test plans. The Simulink-based virtual dynamometer
executed the DoE test plan on GT-POWER 1.5–L SI and CI reference engines. MathWorks
used the Model-Based Calibration Toolbox to develop the engine plant model calibration
maps from the GT-POWER.

Engine Controller Calibration Maps
The engine controller model calibration maps in the reference applications represent the
optimal open-loop control commands for given engine operating points.

To develop the calibration maps for the SI engine controller, MathWorks used the GT-
POWER reference engine models in a virtual engine calibration optimization (VECO)
process. The process optimized the open-loop control commands for 1.5–L SI engine,
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subject to engine operating constraints for knock, turbocharger speed, and exhaust
temperature.

To develop the calibration maps for the CI engine controller, MathWorks used the DOE
test data from the GT-POWER 1.5–L CI reference model operated at minimum brake-
specific fuel consumption (BSFC).

Calibration Maps in Compression-Ignition (CI) Blocks
In the engine models, the Powertrain Blockset blocks implement these calibration maps.
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Map Used For In Description
Volumetric
efficiency

“CI Engine
Speed-Density
Air Mass Flow
Model” on
page 2-29

CI Core
Engine

CI
Controller

The volumetric efficiency lookup table is a
function of the intake manifold absolute
pressure at intake valve closing (IVC) and
engine speed

h hv f MAP N
v

= ( , )

where:

•
h

v
 is engine volumetric efficiency,

dimensionless.
• MAP is intake manifold absolute pressure, in

KPa.
• N is engine speed, in rpm.
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Map Used For In Description
Inner
torque

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The inner torque lookup table, fTqinr , is a
function of engine speed and injected fuel mass,

Tq f F Ninr Tqinr= ( , ) , where:

•
Tqinr  is inner torque based on gross
indicated mean effective pressure, in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Friction
torque

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The friction torque lookup table, fTfric , is a
function of engine speed and injected fuel mass,

T f F,Nfric Tfric= ( ) , where:

•
Tfric  is friction torque offset to inner torque,
in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.
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Map Used For In Description
Pumping
torque

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The pumping torque lookup table, ƒTpump, is a
function of engine speed and injected fuel mass,
Tpump=ƒTpump(F,N), where:

• Tpump is pumping torque, in N.m.
• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Main start-
of-injection
(MAINSOI)
torque
modifier

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The main start-of-injection (MAINSOI) torque
modifier lookup table is a function of MAINSOI
and engine speed

Tmod f MAINSOI, Nmainsoi mainsoi= ( ) , where:

• Tmodmainsoi is the torque modifier due to
MAINSOI torque loss.

• MAINSOI is the main start-of-injection
timing, in degrees crank angle after top dead
center (degATDC).

• N is engine speed, in rpm.
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Map Used For In Description
Intake
manifold
gas
temperature
(MAT)
torque
modifier

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The intake manifold gas temperature (MAT)
torque modifier lookup table is a function of
MAT and engine speed,

Tmod f MAT,Nmat mat= ( ) , where:

• Tmodmat is the torque modifier due to MAT
torque loss.

• MAT is the measured intake manifold gas
pressure, in C.

• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Intake
manifold
absolute
pressure
(MAP)
torque
modifier

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The intake manifold absolute pressure (MAP)
torque modifier lookup table is a function of
MAP and engine speed,

Tmod f MAP,Nmap map= ( ) , where:

• Tmodmap is the torque modifier due to MAP
torque loss.

• MAP is the measured intake manifold
absolute pressure, in kPa.

• N is engine speed, in rpm.
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Map Used For In Description
Unburned
air per
cylinder
(APC)
torque
modifier

“CI Engine
Torque
Structure
Model” on
page 2-33

CI Core
Engine

CI
Controller

The unburned air per cylinder (APC) torque
modifier lookup table is a function of APC and

engine speed, Tmod f APC,Napc apc= ( ) , where:

• Tmodapc is the torque modifier due to APC
torque loss.

• APC is the unburned air per cylinder, in mg.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Engine
brake
torque

“CI Engine
Simple
Torque
Model” on
page 2-40

CI Core
Engine

CI
Controller

For the simple torque lookup table model, the CI
engine uses a lookup table is a function of
engine speed and injected fuel mass,

T f F Nbrake Tnf= ( , ) , where:

• Tq = Tbrake is engine brake torque after
accounting for engine mechanical and
pumping friction effects, in N.m.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.
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Map Used For In Description
Hydrocarbo
n (HC) mass
fraction

HC emissions CI Core
Engine

The CI Core Engine HC emission mass fraction
lookup table is a function of engine torque and
engine speed, HC Mass Fraction = ƒ(Speed,
Torque), where:

• HC Mass Fraction is the HC emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

2 Workflows
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Map Used For In Description
Carbon
monoxide
(CO) mass
fraction

CO emissions CI Core
Engine

The CI Core Engine CO emission mass fraction
lookup table is a function of engine torque and
engine speed, CO Mass Fraction = ƒ(Speed,
Torque), where:

• CO Mass Fraction is the CO emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.
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Map Used For In Description
Nitric oxide
and
nitrogen
dioxide
(NOx) mass
fraction

NOx
emissions

CI Core
Engine

The CI Core Engine NOx emission mass fraction
lookup table is a function of engine torque and
engine speed, NOx Mass Fraction = ƒ(Speed,
Torque), where:

• NOx Mass Fraction is the NOx emission
mass fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

2 Workflows
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Map Used For In Description
Carbon
dioxide
(CO2) mass
fraction

CO2 emissions CI Core
Engine

The CI Core Engine CO2 emission mass fraction
lookup table is a function of engine torque and
engine speed, CO2 Mass Fraction = ƒ(Speed,
Torque), where:

• CO2 Mass Fraction is the CO2 emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.
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Map Used For In Description
Exhaust
temperature

Engine
exhaust
temperature
as a function
of injected
fuel mass and
engine speed

CI Core
Engine

CI
Controller

The lookup table for the exhaust temperature is
a function of injected fuel mass and engine
speed

T f F Nexh Texh= ( , )

where:

•
Texh  is exhaust temperature, in K.

• F is injected fuel mass, in mg per injection.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Engine
brake
torque

Engine brake
torque as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine brake torque lookup table is a
function of commanded fuel mass and engine

speed, Tbrake  = ƒ(F, N), where:

•
Tbrake  is engine torque, in N·m.

• F is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.
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Map Used For In Description
Engine air
mass flow

Engine air
mass flow as
a function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The air mass flow lookup table is a function of

commanded fuel mass and engine speed, &mintk

= ƒ(Fmax, N), where:

•
&mintk  is engine air mass flow, in kg/s.

• Fmax is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Engine fuel
flow

Engine fuel
flow as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine fuel flow lookup table is a function of
commanded fuel mass and engine speed,
MassFlow= ƒ(F, N), where:

• MassFlow is engine fuel mass flow, in kg/s.
• F is commanded fuel mass, in mg per

injection.
• N is engine speed, in rpm.
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Map Used For In Description
Engine
exhaust
temperature

Engine
exhaust
temperature
as a function
of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine exhaust temperature table is a
function of commanded fuel mass and engine
speed, Texh= ƒ(F, N), where:

• Texhis exhaust temperature, in K.
• F is commanded fuel mass, in mg per

injection.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Brake-
specific fuel
consumptio
n (BSFC)
efficiency

BSFC
efficiency as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The brake-specific fuel consumption (BSFC)
efficiency is a function of commanded fuel mass
and engine speed, BSFC= ƒ(F, N), where:

• BSFC is BSFC, in g/kWh.
• F is commanded fuel mass, in mg per

injection.
• N is engine speed, in rpm.
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Map Used For In Description
Engine-out
(EO)
hydrocarbo
n emissions

EO
hydrocarbon
emissions as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine-out hydrocarbon emissions are a
function of commanded fuel mass and engine
speed, EO HC= ƒ(F, N), where:

• EO HC is engine-out hydrocarbon emissions,
in kg/s.

• F is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Engine-out
(EO) carbon
monoxide
emissions

EO carbon
monoxide
emissions as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine-out carbon monoxide emissions are
a function of commanded fuel mass and engine
speed, EO CO= ƒ(F, N), where:

• EO CO is engine-out carbon monoxide
emissions, in kg/s.

• F is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.
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Map Used For In Description
Engine-out
(EO) nitric
oxide and
nitrogen
dioxide

EO nitric
oxide and
nitrogen
dioxide
emissions as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine-out nitric oxide and nitrogen dioxide
emissions are a function of commanded fuel
mass and engine speed, EO NOx= ƒ(F, N),
where:

• EO NOx is engine-out nitric oxide and
nitrogen dioxide emissions, in kg/s.

• F is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Engine-out
(EO) carbon
dioxide
emissions

EO carbon
dioxide
emissions as a
function of
commanded
fuel mass and
engine speed

Mapped
CI Engine

The engine-out carbon dioxide emissions are a
function of commanded fuel mass and engine
speed, EO CO2= ƒ(F, N), where:

• EO CO2 is engine-out carbon dioxide
emissions, in kg/s.

• F is commanded fuel mass, in mg per
injection.

• N is engine speed, in rpm.
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Map Used For In Description
Commanded
exhaust gas
recirculatio
n (EGR)
valve area
percent

Commanded
exhaust gas
recirculation
(EGR) valve
area percent
as a function
of
commanded
torque and
engine speed

CI
Controller

The commanded exhaust gas recirculation
(EGR) valve area percent lookup table is a
function of commanded torque and engine
speed

EGR f Trq Ncmd EGRcmd cmd= ( , )

where:

• EGRcmd is commanded EGR valve area
percent, in percent.

• Trqcmd is commanded engine torque, in N.m.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Variable
geometry
turbocharge
r (VGT) rack
position

Variable
geometry
turbocharger
(VGT) rack
position as a
function of
commanded
torque and
engine speed

CI
Controller

The variable geometry turbocharger (VGT) rack
position lookup table is a function of
commanded torque and engine speed

RP f Trq Ncmd RPcmd cmd= ( , )

where:

• RPcmd is VGT rack position command, in
percent.

• Trqcmd is commanded engine torque, in N.m.
• N is engine speed, in rpm.
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Map Used For In Description
Commanded
total fuel
mass per
injection

Commanded
total fuel
mass per
injection as a
function of
torque
command and
engine speed

CI
Controller

The commanded total fuel mass per injection
table is a function of the torque command and
engine speed

F f Trq Ncmd tot Fcmd tot cmd, , ( , )=

where:

• Fcmd,tot = F is commanded total fuel mass per
injection, in mg per cylinder.

• Trqcmd is commanded engine torque, in N.m.
• N is engine speed, in rpm.

2 Workflows
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Map Used For In Description
Main start-
of-injection
(SOI) timing

SOI timing as
a function of
commanded
fuel mass and
engine speed

CI
Controller

The main start-of-injection (SOI) timing lookup
table is a function of commanded fuel mass and
engine speed

MAINSOI f F Ncmd tot= ( , ),

where:

• MAINSOI is the main start-of-injection
timing, in degrees crank angle after top dead
center (degATDC).

• Fcmd,tot = F is commanded fuel mass, in mg
per injection.

• N is engine speed, in rpm.
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Map Used For In Description
Standard
exhaust gas
recirculatio
n (EGR)
mass flow

EGR mass
flow as a
function of
the standard
flow pressure
ratio and EGR
valve flow
area

CI
Controller

The standard exhaust gas recirculation (EGR)
mass flow is a lookup table that is a function of
the standard flow pressure ratio and EGR valve
flow area

&m f
MAP

P
EGRapegr std

exh est
,

,

( , )=

where:

•
&megr std,

 is the standard EGR valve mass
flow, in g/s.

• Pexh,est is the estimated exhaust back-
pressure, in Pa.

• MAP is the cycle average intake manifold
absolute pressure, in Pa.

• EGRap is the measured EGR valve area, in
percent.

2 Workflows
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Map Used For In Description
Turbocharg
er pressure
ratio

Turbocharger
pressure ratio
as a function
of the
standard air
mass flow and
corrected
turbocharger
speed

CI
Controller

The turbocharger pressure ratio, corrected for
variable geometry turbocharger (VGT) speed, is
a lookup table that is a function of the standard
air mass flow and corrected turbocharger

speed, Pr f m Nturbo airstd vgtcorr= ( , )& , where:

• Prturbo is the turbocharger pressure ratio,
corrected for VGT speed.

•
&m

airstd  is the standard air mass flow, in g/s.
• Nvgtcorr is the corrected turbocharger speed,

in rpm/K^(1/2).
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Map Used For In Description
Turbocharg
er pressure
ratio
correction

Turbocharger
pressure ratio
correction as
a function of
the rack
position

CI
Controller

The variable geometry turbocharger pressure
ratio correction is a function of the rack
position, Prvgtcorr= ƒ(VGTpos), where:

• Prvgtcorr is the turbocharger pressure ratio
correction.

• VGTpos is the variable geometry turbocharger
(VGT) rack position.

Calibration Maps in Spark-Ignition (SI) Blocks
In the engine models, the Powertrain Blockset blocks implement these calibration maps.

2 Workflows
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Map Used for In Description
Engine
volumetric
efficiency

“SI Engine
Speed-Density
Air Mass Flow
Model” on
page 2-14

SI Core
Engine

SI
Controller

The engine volumetric efficiency lookup table,

f
vh , is a function of intake manifold absolute

pressure and engine speed

h hv f MAP N
v

= ( , )

where:

•
h

v
 is engine volumetric efficiency,

dimensionless.
• MAP is intake manifold absolute pressure, in

KPa.
• N is engine speed, in rpm.
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Map Used for In Description
Cylinder
volume at
intake valve
close table
(IVC)

“SI Engine
Dual-
Independent
Cam Phaser
Air Mass Flow
Model” on
page 2-5

SI Core
Engine

SI
Controller

The cylinder volume at intake valve close table

(IVC), fVivc  is a function of the intake cam
phaser angle

V fIVC Vivc ICP= ( )j

where:

•
VIVC  is cylinder volume at IVC, in L.

•
jICP  is intake cam phaser angle, in crank
advance degrees.

2 Workflows
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Map Used for In Description
Trapped
mass
correction

“SI Engine
Dual-
Independent
Cam Phaser
Air Mass Flow
Model” on
page 2-5

SI Core
Engine

SI
Controller

The trapped mass correction factor table,

fTMcorr , is a function of the normalized density
and engine speed

TM f Ncorr TMcorr norm= (   ),r

where:

•
TM

corr , is trapped mass correction
multiplier, dimensionless.

•
r

norm
 is normalized density, dimensionless.

• N is engine speed, in rpm.

 Engine Calibration Maps

2-75



Map Used for In Description
Air mass
flow at cam
phaser
angles

“SI Engine
Dual-
Independent
Cam Phaser
Air Mass Flow
Model” on
page 2-5

SI Core
Engine

SI
Controller

The phaser intake mass flow model lookup table
is a function of exhaust cam phaser angles and
trapped air mass flow

&m f TMintkideal intkideal ECP flow= ( , )j

where:

•
&mintkideal  is engine intake port mass flow at

arbitrary cam phaser angles, in g/s.
•

jECP  is exhaust cam phaser angle, in
degrees crank retard.

•
TM flow  is flow rate equivalent to corrected
trapped mass at the current engine speed, in
g/s.

2 Workflows
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Map Used for In Description
Air mass
flow
correction

“SI Engine
Dual-
Independent
Cam Phaser
Air Mass Flow
Model” on
page 2-5

SI Core
Engine

SI
Controller

The intake air mass flow correction lookup

table, faircorr , is a function of ideal load and
engine speed

& &m m f L Nair intkideal aircorr ideal= ( , )

where:

•
L

ideal  is engine load (normalized cylinder air
mass) at arbitrary cam phaser angles,
uncorrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.
•

&m
air  is engine intake air mass flow final

correction at steady-state cam phaser
angles, in g/s.

•
&mintkideal  is engine intake port mass flow at

arbitrary cam phaser angles, in g/s.
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Map Used for In Description
Inner
torque

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The inner torque lookup table, fTqinr , is a
function of engine speed and engine load,

Tq f L Ninr Tqinr= ( , ) , where:

•
Tqinr  is inner torque based on gross
indicated mean effective pressure, in N.m.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Friction
torque

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The friction torque lookup table, fTfric , is a
function of engine speed and engine load,

T f L,Nfric Tfric= ( ) , where:

•
Tfric  is friction torque offset to inner torque,
in N.m.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.
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Map Used for In Description
Pumping
torque

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The pumping torque lookup table, ƒTpump, is a
function of engine speed and injected fuel mass,
Tpump=ƒTpump(L,N), where:

• Tpump is pumping torque, in N.m.
• L is engine load, as a normalized cylinder air

mass, dimensionless.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Optimal
spark
advance

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The optimal spark lookup table, fSAopt , is a
function of engine speed and engine load,

SA f L Nopt SAopt= ( , ) , where:

• SAopt is optimal spark advance timing for
maximum inner torque at stoichiometric air-
fuel ratio (AFR), in deg.

• L is engine load at arbitrary cam phaser
angles, corrected for final steady-state cam
phaser angles, dimensionless.

• N is engine speed, in rpm.
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Map Used for In Description
Spark
efficiency

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The spark efficiency lookup table, fMsa , is a
function of the spark retard from optimal

M f SA

SA SA SA

sa Msa

opt

=

= -

( )D

D

where:

•
M

sa  is the spark retard efficiency multiplier,
dimensionless.

•
DSA is the spark retard timing distance from
optimal spark advance, in deg.

2 Workflows
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Map Used for In Description
Lambda
efficiency

“SI Engine
Torque
Structure
Model” on
page 2-17

SI Core
Engine

SI
Controller

The lambda efficiency lookup table, fMl , is a

function of lambda, M fMl l l= ( ) , where:

•
Ml  is the lambda multiplier on inner torque
to account for the air-fuel ratio (AFR) effect,
dimensionless.

•
l  is lambda, AFR normalized to
stoichiometric fuel AFR, dimensionless.
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Map Used for In Description
Simple
torque

“SI Engine
Simple
Torque
Model” on
page 2-26

SI Core
Engine

SI
Controller

For the simple torque lookup table model, the SI
engine uses a lookup table map that is a
function of engine speed and load,

T f L Nbrake TnL= ( , ) , where:

•
Tbrake  is engine brake torque after
accounting for spark advance, AFR, and
friction effects, in N.m.

• L is engine load, as a normalized cylinder air
mass, dimensionless.

• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Hydrocarbo
n (HC) mass
fraction

HC emissions SI Core
Engine

The SI Core Engine HC emission mass fraction
lookup table is a function of engine torque and
engine speed, HC Mass Fraction = ƒ(Speed,
Torque), where:

• HC Mass Fraction is the HC emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

 Engine Calibration Maps

2-85



Map Used for In Description
Carbon
monoxide
(CO) mass
fraction

CO emissions SI Core
Engine

The SI Core Engine CO emission mass fraction
lookup table is a function of engine torque and
engine speed, CO Mass Fraction = ƒ(Speed,
Torque), where:

• CO Mass Fraction is the CO emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

2 Workflows
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Map Used for In Description
Nitric oxide
and
nitrogen
dioxide
(NOx) mass
fraction

NOx
emissions

SI Core
Engine

The SI Core Engine NOx emission mass fraction
lookup table is a function of engine torque and
engine speed, NOx Mass Fraction = ƒ(Speed,
Torque), where:

• NOx Mass Fraction is the NOx emission
mass fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

 Engine Calibration Maps

2-87



Map Used for In Description
Carbon
dioxide
(CO2) mass
fraction

CO2 emissions SI Core
Engine

The SI Core Engine CO2 emission mass fraction
lookup table is a function of engine torque and
engine speed, CO2 Mass Fraction = ƒ(Speed,
Torque), where:

• CO2 Mass Fraction is the CO2 emission mass
fraction, dimensionless.

• Speed is engine speed, in rpm.
• Torque is engine torque, in N.m.

2 Workflows
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Map Used for In Description
Exhaust
temperature

Engine
exhaust
calculation as
a function of
engine speed
and load

SI Core
Engine

SI
Controller

The exhaust temperature lookup table, fTexh , is
a function of engine load and engine speed

T f L Nexh Texh= ( , )

where:

• Texh is engine exhaust temperature, in K.
• L is normalized cylinder air mass or engine

load, dimensionless.
• N is engine speed, in rpm.
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Map Used for In Description
Engine
torque

Engine brake
torque as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine torque lookup table is a function of
commanded engine torque and engine speed, T
= ƒ(Tcmd, N), where:

• T is engine torque, in N·m.
• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Engine air
mass flow

Engine air
mass flow as
a function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine air mass flow lookup table is a
function of commanded engine torque and

engine speed, &mintk  = ƒ(Tcmd, N), where:

•
&mintk  is engine air mass flow, in kg/s.

• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Engine fuel
flow

Engine fuel
flow as a
function of
commanded
torque mass
and engine
speed

Mapped
SI Engine

The engine fuel mass flow lookup table is a
function of commanded engine torque and
engine speed, MassFlow = ƒ(Tcmd, N), where:

• MassFlow is engine fuel mass flow, in kg/s.
• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Engine
exhaust
temperature

Engine
exhaust
temperature
as a function
of
commanded
torque and
engine speed

Mapped
SI Engine

The engine exhaust temperature lookup table is
a function of commanded engine torque and
engine speed, Texh = ƒ(Tcmd, N), where:

• Texh is exhaust temperature, in K.
• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.
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Map Used for In Description
Brake-
specific fuel
consumptio
n (BSFC)
efficiency

Brake-specific
fuel
consumption
(BSFC) as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The brake-specific fuel consumption (BSFC)
efficiency is a function of commanded engine
torque and engine speed, BSFC = ƒ(Tcmd, N),
where:

• BSFC is BSFC, in g/kWh.
• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Engine-out
(EO)
hydrocarbo
n emissions

EO
hydrocarbon
emissions as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine-out hydrocarbon emissions are a
function of commanded engine torque and
engine speed, EO HC = ƒ(Tcmd, N), where:

• EO HC is engine-out hydrocarbon emissions,
in kg/s.

• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Engine-out
(EO) carbon
monoxide
emissions

EO carbon
monoxide
emissions as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine-out carbon monoxide emissions are
a function of commanded engine torque and
engine speed, EO CO = ƒ(Tcmd, N), where:

• EO CO is engine-out carbon monoxide
emissions, in kg/s.

• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Engine-out
(EO) nitric
oxide and
nitrogen
dioxide
emissions

EO nitric
oxide and
nitrogen
dioxide
emissions as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine-out nitric oxide and nitrogen dioxide
emissions are a function of commanded engine
torque and engine speed, EO NOx = ƒ(Tcmd, N),
where:

• EO NOx is engine-out nitric oxide and
nitrogen dioxide emissions, in kg/s.

• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Engine-out
(EO) carbon
dioxide
emissions

EO carbon
dioxide
emissions as a
function of
commanded
torque and
engine speed

Mapped
SI Engine

The engine-out carbon dioxide emissions are a
function of commanded engine torque and
engine speed, EO CO2 = ƒ(Tcmd, N), where:

• EO CO2 is engine-out carbon dioxide
emissions, in kg/s.

• Tcmd is commanded engine torque, in N·m.
• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Wastegate
area
percent
command

Wastegate
area percent
command as a
function of
the
commanded
engine load
and engine
speed

SI
Controller

The wastegate area percent command lookup

table, fWAPcmd , is a function of the commanded
engine load and engine speed

WAP f L Ncmd WAPcmd cmd= ( ),

where:

• WAPcmd is wastegate area percentage
command, in percent.

• Lcmd=L is commanded engine load,
dimensionless.

• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Throttle
position
percent
command

Throttle
position
percent
command as a
function of
the throttle
area
percentage
command

SI
Controller

The throttle position percent command lookup

table, fTPPcmd , is a function of the throttle area
percentage command

TPP f TAPcmd TPPcmd cmd= ( )

where:

• TPPcmd is throttle position percentage
command, in percent.

• TAPcmd is throttle area percentage command,
in percent.

2 Workflows
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Map Used for In Description
Throttle
area
percent
command

Throttle area
percent
command as a
function of
commanded
load and
engine speed

SI
Controller

The throttle area percent command lookup

table, fTAPcmd , is a function of commanded load
and engine speed

TAP f L Ncmd TAPcmd cmd= ( ),

where:

• TAPcmd is throttle area percentage command,
in percent.

• Lcmd=L is commanded engine load,
dimensionless.

• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Spark
advance

Spark
advance as a
function of
estimated
load and
engine speed

SI
Controller

The spark advance lookup table is a function of
estimated load and engine speed.

SA f L NSA est= ( ),

where:

• SA is spark advance, in crank advance
degrees.

• Lest=L is estimated engine load,
dimensionless.

• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Commanded
lambda

Commanded
lambda as a
function of
estimated
engine load
and measured
engine speed

SI
Controller The commanded lambda, l

cmd , lookup table is
a function of estimated engine load and
measured engine speed

l lcmd cmd estf L N= ( ),

where:

•
l

cmd  is commanded relative AFR,
dimensionless.

• Lest=L is estimated engine load,
dimensionless.

• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Intake cam
phaser
angle
command

Intake cam
phaser angle
command as a
function of
the engine
load and
engine speed

SI
Controller

The intake cam phaser angle command lookup

table, fICPCMD , is a function of the engine load
and engine speed

jICPCMD ICPCMD estf L N= ( ),

where:

•
jICPCMD  is commanded intake cam phaser
angle, in degrees crank advance.

• Lest=L is estimated engine load,
dimensionless.

• N is engine speed, in rpm.

2 Workflows
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Map Used for In Description
Commanded
engine load

Commanded
engine load
as a function
of the
commanded
torque and
engine speed

SI
Controller

The commanded engine load lookup table,

fLcmd , is a function of the commanded torque
and engine speed

L f T Ncmd Lcmd cmd= ( ),

where:

• Lcmd=L is commanded engine load,
dimensionless.

• Tcmd is commanded torque, in N.m.
• N is engine speed, in rpm.

 Engine Calibration Maps
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Map Used for In Description
Exhaust
cam phaser
angle

Exhaust cam
phaser angle
as a function
of the engine
load and
engine speed

SI
Controller

The exhaust cam phaser angle command lookup

table, fECPCMD , is a function of the engine load
and engine speed

jECPCMD ECPCMD estf L N= ( ),

where:

•
jECPCMD  is commanded exhaust cam
phaser angle, in degrees crank retard.

• Lest=L is estimated engine load,
dimensionless.

• N is engine speed, in rpm.

See Also
CI Controller | CI Core Engine | Mapped SI Engine | Mapped CI Engine | SI Controller | SI
Core Engine

External Websites
• Virtual Engine Calibration: Making Engine Calibration Part of the Engine Hardware

Design Process

2 Workflows
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Internal Combustion Engine Reference Application
Projects

Use these reference application projects as a starting point for your own vehicle and
internal combustion engine models.

Objective Model Reference
Design tradeoff analysis
and component sizing,
control parameter
optimization, or hardware-
in-the-loop (HIL) testing.

Full conventional vehicle
with spark-ignition (SI) or
combustion-ignition (CI)

“Explore the Conventional
Vehicle Reference Application”
on page 3-4

Engine and controller
calibration, validation, and
optimization before
integration with the
vehicle model.

CI engine plant and
controller

“Explore the CI Engine
Dynamometer Reference
Application” on page 3-9

SI engine plant and
controller

“Explore the SI Engine
Dynamometer Reference
Application” on page 3-14

See Also

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7
• “Resize the CI Engine” on page 3-36
• “Resize the SI Engine” on page 3-45

More About
• “Hybrid and Electric Vehicle Reference Application Projects” on page 3-3
• “Engine Calibration Maps” on page 2-41
• “Internal Combustion Mapped and Dynamic Engine Models” on page 3-65

3 Reference Applications
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Hybrid and Electric Vehicle Reference Application
Projects

Use these reference applications as a starting point for your own vehicle hybrid and
electric vehicle models.

Objective Model Reference
Design tradeoff analysis
and component sizing,
control parameter
optimization, or hardware-
in-the-loop (HIL) testing.

Hybrid electric vehicle
(HEV) — Multimode

“Explore the Hybrid Electric
Vehicle Multimode Reference
Application” on page 3-19

HEV — Input power-split “Explore the Hybrid Electric
Vehicle Input Power-Split
Reference Application” on page
3-28

Electric vehicle “Explore the Electric Vehicle
Reference Application” on page
3-25

See Also

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7

More About
• “Internal Combustion Engine Reference Application Projects” on page 3-2

 Hybrid and Electric Vehicle Reference Application Projects
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Explore the Conventional Vehicle Reference Application
The conventional vehicle reference application represents a full vehicle model with an
internal combustion engine, transmission, and associated powertrain control algorithms.
Use the reference application for powertrain matching analysis and component selection,
control and diagnostic algorithm design, and hardware-in-the-loop (HIL) testing. To create
and open a working copy of the conventional vehicle reference application project, enter

autoblkConVehStart 

By default, the conventional vehicle reference application is configured with these
powertrain subsystem variants:

• 1.5–L spark-ignition (SI) dynamic engine
• Performance mode transmission controller

This table summarizes the blocks and subsystems in the reference application. Some
subsystems contain variants. To implement the model variants, the reference application
uses variant subsystems.

Reference Application
Element

Description Variants

Drive Cycle Source block Generates a standard or
user-specified drive cycle
velocity versus time profile.
Block output is the selected
or specified vehicle
longitudinal speed.

 

Environment subsystem Creates environment
variables, including road
grade, wind velocity, and
ambient temperature and
pressure.

 

Longitudinal Driver
subsystem

Uses the Longitudinal
Driver block to generate
normalized acceleration and
braking commands based on
vehicle target and feedback
velocities.

 

3 Reference Applications
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Reference Application
Element

Description Variants

Controllers subsystem Implements a powertrain
control module (PCM)
containing a transmission
control module (TCM) and
engine control module
(ECM).

✓

Passenger Car subsystem Implements a passenger car
that contains transmission
drivetrain and engine plant
model subsystems.

✓

Visualization subsystem Displays vehicle-level
performance, fuel economy,
and emission results that
are useful for powertrain
matching and component
selection analysis.

 

Drive Cycle Source
The Drive Cycle Source block generates a target vehicle velocity for a selected or
specified drive cycle. The reference application has these options.

Timing Variant Description
Output
sample time

Discrete (default) Discrete operator commands
Continuous Continuous operator commands

Longitudinal Driver
The Longitudinal Driver subsystem generates normalized acceleration and braking
commands based on the target vehicle velocity. The reference application has these
options.

 Explore the Conventional Vehicle Reference Application
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Filter Options Description
Low-pass
filter (LPF)

pass Do not use a filter on velocity error.
LPF (default) Use an LPF on target velocity error

for smoother driving.

Controllers
To implement a powertrain control module (PCM), the Controller subsystem has a
transmission control module (TCM) and an engine control module (ECM). The reference
application has these variants.

Controller Variant Description
Engine
controller —
ECM

SiEngineController (default) SI engine controller
CiEngineController CI engine controller

Transmission
controller —
TCM

PowertrainMaxPowerController
(default)

Performance mode transmission
controller

PowertrainBestFuelController Fuel economy mode transmission
controller

Passenger Car
To implement a passenger car, the Passenger Car subsystem contains drivetrain and
engine plant model subsystems. To create your own internal combustion engine variants
for the reference application, use the CI and SI engine project templates. The reference
application has these variants.

Drivetrain
Subsystem

Variant Description

Dual clutch
transmission
(DCT)

DCT Block (default) Configure drivetrain with DCT block
or DCT system. For the DCT system,
you can configure the type of filter.

DCT System

Differential
and
Compliance

All Wheel Drive Configure drivetrain for all wheel,
front wheel, or rear wheel drive.Front Wheel Drive (default)

Rear Wheel Drive

3 Reference Applications

3-6



Drivetrain
Subsystem

Variant Description

Vehicle Vehicle Body 3 DOF
Longitudinal

Vehicle configured for 3 degrees of
freedom.

Wheels and
Brakes

All Wheel Drive Configure drivetrain for all wheel,
front wheel, or rear wheel drive. For
the wheels, you can configure the
type of:

• Brake
• Force calculation
• Resistance calculation
• Vertical motion

Front Wheel Drive (default)
Rear Wheel Drive

Engine
Subsystem

Variant Description

Engine SiEngine (default) Dynamic SI engine with
turbocharger

SiMappedEngine Mapped SI engine with implicit
turbocharger

CiEngine Dynamic CI engine with
turbocharger

CiMappedEngine Mapped CI engine with implicit
turbocharger

See Also
CI Controller | CI Core Engine | Drive Cycle Source | Longitudinal Driver | Mapped CI
Engine | Mapped SI Engine | SI Controller | SI Core Engine

Related Examples
• “Conventional Vehicle Fuel Economy and Emissions” on page 1-12
• “Create CI and SI Engines Using Project Templates” on page 4-7

 See Also
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More About
• “Internal Combustion Mapped and Dynamic Engine Models” on page 3-65
• “Variant Systems” (Simulink)

3 Reference Applications
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Explore the CI Engine Dynamometer Reference
Application

The compression-ignition (CI) engine dynamometer reference application represents a CI
engine plant and controller connected to an AC dynamometer with a tailpipe emission
analyzer. Using the reference application, you can calibrate, validate, and optimize the
engine controller and plant model parameters before integrating the engine with the
vehicle model. To create and open a working copy of the CI engine dynamometer
reference application project, enter

autoblkCIDynamometerStart 

By default, the reference application is configured with a 1.5–L CI dynamic engine.

You can configure the reference application project for different dynamometer control
modes. To implement the operating modes, the reference application uses variant
subsystems.

This table summarizes the dynamometer tests.

Test Objective Method CI Engine Variant
Mapped Dynamic

Execute Engine
Mapping
Experiment

Assess engine
torque, fuel flow,
and emission
performance
results using an
existing engine
controller
calibration.

Dynamometer controller
commands a series of
engine speeds and torques
to the engine controller. At
each quasi-steady-state
operating point, the
experiment records the
engine plant model output
and the controller
commands for the current
calibration parameters.

✓ ✓

 Explore the CI Engine Dynamometer Reference Application

3-9

matlab:autoblkCIDynamometerStart


Test Objective Method CI Engine Variant
Mapped Dynamic

Execute Model
Predictive
Control Plant
Model
Experiment

Generate transient
engine datasets for
linear plant models
useful for model
predictive
controllers.

Dynamometer controller
commands engine speed
and torque dynamically as
a function of time using a
pseudorandom binary
sequence. Experiment
records the transient
engine torque,
temperature, airflow, and
emission responses
determined from linear
dynamic plant model fitting
via system identification.

✓ ✓

Recalibrate
Controller

Match measured
engine torque to
commanded engine
torque across
engine operating
range.

Dynamometer controller
generates a feedforward
fuel command table by
matching the measured
engine torque to the
commanded engine torque
across the engine operating
range.

 ✓

Resize Engine
and Recalibrate
Controller

Match engine
torque to desired
engine power and
number of
cylinders.

Dynamometer resizes the
dynamic engine and engine
calibration parameters.
Additionally, the
dynamometer recalibrates
the controller and mapped
engine model to match the
resized dynamic engine.

✓ ✓

3 Reference Applications
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Test Objective Method CI Engine Variant
Mapped Dynamic

Generate
Mapped Engine
from
Spreadsheet

Generate a mapped
engine calibration
from a data
spreadsheet.
Update the mapped
engine with the
calibrated data.

Dynamometer uses the
Model-Based Calibration
Toolbox to fit data from a
spreadsheet, generate
calibrated tables, and
update the mapped engine
parameters.

✓  

Engine System
The reference application includes variant subsystems for mapped (steady-state) and
dynamic 1.5–L CI engine systems with a variable geometry turbocharger (VGT). Using the
CI engine project template, you can create your own CI engine variants.

Objective Engine Variant
Dynamic analysis, including manifold and
turbocharger dynamics

Dynamic

Faster execution Mapped

Dynamic

CiEngineCore.slx contains the engine intake system, exhaust system, exhaust gas
recirculation (EGR), fuel system, core engine, and turbocharger subsystems.

 Explore the CI Engine Dynamometer Reference Application
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Mapped

CiMappedEngine.slx uses the Mapped CI Engine block to look up power, air mass flow,
fuel flow, exhaust temperature, efficiency, and emission performance as functions of
engine speed and injected fuel mass.

Performance Monitor
The reference application contains a Performance Monitor block that you can use to plot
steady-state and dynamic results. You can plot:

• Steady-state results as a function of one or two variables.
• Dynamic results using the Simulation Data Inspector.

3 Reference Applications
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See Also
CI Controller | CI Core Engine | Mapped CI Engine

More About
• “CI Engine Project Template” on page 4-2
• “Generate Mapped CI Engine from a Spreadsheet” on page 3-54
• “Resize the CI Engine” on page 3-36
• “Internal Combustion Mapped and Dynamic Engine Models” on page 3-65
• “Variant Systems” (Simulink)

 See Also
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Explore the SI Engine Dynamometer Reference
Application

The spark-ignition (SI) engine dynamometer reference application represents a SI engine
plant and controller connected to an AC dynamometer with a tailpipe emission analyzer.
Using the reference application, you can calibrate, validate, and optimize the engine
controller and plant model parameters before integrating the engine with the vehicle
model. To create and open a working copy of the SI engine dynamometer reference
application project, enter

autoblkSIDynamometerStart 

By default, the reference application is configured with a 1.5–L SI dynamic engine.

You can configure the reference application project for different dynamometer control
modes. To implement the operating modes, the reference application uses variant
subsystems.

This table summarizes the dynamometer tests.

Test Objective Method SI Engine
Variant

Mapped Dynam
ic

Execute Engine
Mapping
Experiment

Assess engine
torque, fuel
flow, and
emission
performance
results using an
existing engine
controller
calibration.

Dynamometer controller
commands a series of engine
speeds and torques to the engine
controller. At each quasi-steady-
state operating point, the
experiment records the engine
plant model output and the
controller commands for the
current calibration parameters.

✓ ✓

3 Reference Applications
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Test Objective Method SI Engine
Variant

Mapped Dynam
ic

Execute Model
Predictive
Control Plant
Model
Experiment

Generate
transient
engine datasets
for linear plant
models useful
for model
predictive
controllers.

Dynamometer controller
commands engine speed and
torque dynamically as a function of
time using a pseudorandom binary
sequence. Experiment records the
transient engine torque,
temperature, airflow, and emission
responses determined from linear
dynamic plant model fitting via
system identification.

✓ ✓

Recalibrate
Controller

Match
measured
engine torque
to commanded
engine torque
across engine
operating
range.

Dynamometer controller generates
a feedforward throttle table by
matching the measured engine
torque to the commanded engine
torque across the engine operating
range.

 ✓

Resize Engine
and Recalibrate
Controller

Match engine
torque to
desired engine
power and
number of
cylinders.

Dynamometer resizes the dynamic
engine and engine calibration
parameters. Additionally, the
dynamometer recalibrates the
controller and mapped engine
model to match the resized
dynamic engine.

✓ ✓
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Test Objective Method SI Engine
Variant

Mapped Dynam
ic

Generate
Mapped Engine
from
Spreadsheet

Generate a
mapped engine
calibration from
a data
spreadsheet.
Update the
mapped engine
with the
calibrated data.

Dynamometer uses the Model-
Based Calibration Toolbox to fit
data from a spreadsheet, generate
calibrated tables, and update the
mapped engine parameters.

✓  

Engine System
The reference application includes variant subsystems for mapped (steady-state) and
dynamic turbocharged 1.5–L SI engine. Using the SI engine project template, you can
create your own SI engine variants.

Objective Engine Variant
Dynamic analysis, including manifold and
turbocharger dynamics

Dynamic

Faster execution Mapped

Dynamic

SiEngineCore.slx contains the engine intake system, exhaust system, core engine, and
turbocharger subsystems.

3 Reference Applications
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Mapped

SiMappedEngine.slx uses the Mapped SI Engine block to look up power, air mass flow,
fuel flow, exhaust temperature, efficiency, and emission performance as functions of
engine speed and commanded torque.

Performance Monitor
The reference application contains a Performance Monitor block that you can use to plot
steady-state and dynamic results. You can plot:

• Steady-state results as a function of one or two variables.
• Dynamic results using the Simulation Data Inspector.

See Also
Mapped SI Engine | SI Controller | SI Core Engine

 See Also
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More About
• “SI Engine Project Template” on page 4-5
• “Generate Mapped SI Engine from a Spreadsheet” on page 3-60
• “Resize the SI Engine” on page 3-45
• “Internal Combustion Mapped and Dynamic Engine Models” on page 3-65
• “Variant Systems” (Simulink)
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Explore the Hybrid Electric Vehicle Multimode Reference
Application

The hybrid electric vehicle reference application represents a full multimode hybrid
electric vehicle (HEV) model with an internal combustion engine, transmission, battery,
motor, generator, and associated powertrain control algorithms. Use the reference
application for powertrain matching analysis and component selection, control and
diagnostic algorithm design, and hardware-in-the-loop (HIL) testing. To create and open a
working copy of the hybrid electric vehicle reference application project, enter

autoblkHevStart 

By default, the HEV multimode reference application is configured with:

• Mapped motor and generator
• 1.5–L spark-ignition (SI) dynamic engine

This table summarizes the blocks and subsystems in the reference application. Also
indicated are subsystems that contain variants. To implement the model variants, the
reference application uses variant subsystems.

Reference Application
Element

Description Variants

Drive Cycle Source block Generates a standard or
user-specified drive cycle
velocity versus time profile.
Block output is the selected
or specified vehicle
longitudinal speed.

 

Environment subsystem Creates environment
variables, including road
grade, wind velocity, and
atmospheric temperature
and pressure.

 

 Explore the Hybrid Electric Vehicle Multimode Reference Application
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Reference Application
Element

Description Variants

Longitudinal Driver
subsystem

Uses the Longitudinal
Driver block to generate
normalized acceleration and
braking commands based on
vehicle target and feedback
velocities.

 

Controllers subsystem Implements a powertrain
control module (PCM)
containing a hybrid control
module (HCM) and an
engine control module
(ECM).

✓

Passenger Car subsystem Implements a hybrid
passenger car that contains
engine, electric plant, and
drivetrain subsystems.

✓

Visualization subsystem Displays vehicle-level
performance, battery state
of charge (SOC), fuel
economy, and emission
results that are useful for
powertrain matching and
component selection
analysis.

 

Drive Cycle Source
The Drive Cycle Source block generates a target vehicle velocity for a selected or
specified drive cycle. The reference application has these options.

Timing Options Description
Output
sample time

Discrete (default) Discrete operator commands
Continuous Continuous operator commands

3 Reference Applications
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Longitudinal Driver
The Longitudinal Driver subsystem generates normalized acceleration and braking
commands based on the target vehicle velocity. The reference application has these
options.

Filter Options Description
Low-pass
filter (LPF)

pass Do not use a filter on velocity error.
LPF (default) Use an LPF on target velocity error

for smoother driving.

Controllers
The Controller subsystem has a PCM with a HCM and an ECM. The reference
application has these variants for the ECM.

Controller Variant Description
ECM SiEngineController (default) SI engine controller

CiEngineController CI engine controller

The HCM implements a dynamic embedded controller that directly determines the engine
operating point that minimizes brake-specific fuel consumption (BSFC) while meeting or
exceeding power required by the battery charging and vehicle propulsion subsystems.

To calculate the optimal engine operating point in speed and torque, the controller starts
with a candidate set of discrete engine power levels. For each power level candidate, the
block has a parameterized vector of torque and speed operating points that minimize
BSFC.

 Explore the Hybrid Electric Vehicle Multimode Reference Application
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The optimizer then removes power level candidates that are unacceptable for either of
these reasons:

• Too much power sent through the generator to the battery.
• Too little power to meet charging and propulsion subsystem requirements.

Of the remaining power level candidates, the controller selects the one with the lowest
BSFC. The controller then sends the associated torque / speed operating point command
to the engine.

Passenger Car
To implement a passenger car, the Passenger Car subsystem contains drivertrain,
electric plant, and engine subsystems. To create your own engine variants for the
reference application, use the CI and SI engine project templates. The reference
application has these variants.

3 Reference Applications
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Drivetrain
Subsystem

Variant Description

Vehicle Vehicle Body 3 DOF
Longitudinal

Configured for 3 degrees of freedom

Wheels and
Brakes

Longitudinal Wheel - Front For the wheels, you can configure
the type of:

• Brake
• Force calculation
• Resistance calculation
• Vertical motion

Longitudinal Wheel - Rear

Electric Plant
Subsystem

Variant Description

Battery BattHevMm (default) Configured with electric battery
Generator GenMapped (default) Mapped generator

GenDynamic Interior permanent magnet
synchronous motor (PMSM) with
controller

Motor MotMapped (default) Mapped motor with implicit
controller

MotDynamic Interior permanent magnet
synchronous motor (PMSM) with
controller

Engine
Subsystem

Variant Description

Engine SiEngine (default) Dynamic SI engine with
turbocharger

SiMappedEngine Mapped SI engine with implicit
turbocharger

CiEngine Dynamic CI engine with
turbocharger

 Explore the Hybrid Electric Vehicle Multimode Reference Application
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Engine
Subsystem

Variant Description

CiMappedEngine Mapped CI engine with implicit
turbocharger

References
[1] Higuchi, N., Shimada, H., Sunaga, Y., and Tanaka, M., Development of a New Two-

Motor Plug-In Hybrid System. SAE Technical Paper 2013-01-1476. Warrendale,
PA: SAE International Journal of Alternative Powertrains, 2013.

See Also
CI Controller | CI Core Engine | Datasheet Battery | Drive Cycle Source | Interior PMSM |
Interior PM Controller | Longitudinal Driver | Mapped CI Engine | Mapped SI Engine | SI
Controller | SI Core Engine

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7
• “Explore the Hybrid Electric Vehicle Input Power-Split Reference Application” on

page 3-28

More About
• “Variant Systems” (Simulink)
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Explore the Electric Vehicle Reference Application
The electric vehicle reference application represents a full electric vehicle model with a
motor-generator, battery, direct-drive transmission, and associated powertrain control
algorithms. Use the electric vehicle reference application for powertrain matching
analysis and component selection, control and diagnostic algorithm design, and
hardware-in-the-loop (HIL) testing. To create and open a working copy of the conventional
vehicle reference application project, enter

autoblkEvStart 

By default, the hybrid vehicle reference application is configured with a mapped motor
and generator.

Reference Application
Element

Description Variants

Drive Cycle Source block Generates a standard or
user-specified drive cycle
velocity versus time profile.
Block output is the selected
or specified vehicle
longitudinal speed.

 

Environment subsystem Creates environment
variables, including road
grade, wind velocity, and
atmospheric temperature
and pressure.

 

Longitudinal Driver
subsystem

Uses the Longitudinal
Driver block to generate
normalized acceleration and
braking commands based on
vehicle target and feedback
velocities.

 

Controllers subsystem Implements a powertrain
control module (PCM) with
an electric vehicle power
management system.
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Reference Application
Element

Description Variants

Passenger Car subsystem Implements a passenger car
that contains an electric
plant and drivetrain
subsystems.

✓

Visualization subsystem Displays vehicle-level
performance, battery state
of charge (SOC), and
equivalent fuel economy
results that are useful for
powertrain matching and
component selection
analysis.

 

Drive Cycle Source
The Drive Cycle Source block generates a target vehicle velocity for a selected or
specified drive cycle. The reference application has these options.

Timing Options Description
Output
sample time

Continuous Continuous operator commands
Discrete (default) Discrete operator commands

Longitudinal Driver
The Longitudinal Driver subsystem generates normalized acceleration and braking
commands based on the target vehicle velocity. The reference application has these
options.

Filter Options Description
Low-pass
filter (LPF)

pass Do not use a filter on velocity error.
LPF (default) Use an LPF on target velocity error

for smoother driving.
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Passenger Car
To implement a passenger car, the Passenger Car subsystem contains a drivertrain and
electric plant subsystem. The reference application has these variants.

Drivetrain
Subsystem

Variant Description

Vehicle Vehicle Body 3 DOF
Longitudinal

Configured for 3 degrees of freedom

Wheels and
Brakes

Longitudinal Wheel - Front For the wheels, you can configure
the type of:

• Brake
• Force calculation
• Resistance calculation
• Vertical motion

Longitudinal Wheel - Rear

Electric
Plant
Subsystem

Variant Description

Battery BattEv (default) Configured with electric battery.
Motor MotGenEvMapped (default) Mapped motor with implicit

controller
MotGenEvDynamic Interior permanent magnet

synchronous motor (PMSM) with
controller

See Also
Datasheet Battery | Drive Cycle Source | Interior PM Controller | Interior PMSM |
Longitudinal Driver | Mapped Motor

More About
• “Variant Systems” (Simulink)
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Explore the Hybrid Electric Vehicle Input Power-Split
Reference Application

The hybrid electric vehicle (HEV) input power-split reference application represents a full
HEV model with an internal combustion engine, transmission, battery, motor, generator,
and associated powertrain control algorithms. Use the HEV input power-split reference
application for HIL testing, tradeoff analysis, and control parameter optimization of a
power-split hybrid like the Toyota® Prius®. To create and open a working copy of the HEV
input power-split reference application project, enter

autoblkHevIpsStart 

By default, the HEV input power-split reference application is configured with:

• Nickel-metal hydride (NiMH) battery pack
• Mapped electric motors
• Mapped spark-ignition (SI) engine

This table summarizes the blocks and subsystems in the reference application. Also
indicated are subsystems that contain variants. To implement the model variants, the
reference application uses variant subsystems.

Reference Application
Element

Description Variants

Drive Cycle Source block Generates a standard or
user-specified drive cycle
velocity versus time profile.
Block output is the selected
or specified vehicle
longitudinal speed.

 

Environment subsystem Creates environment
variables, including road
grade, wind velocity, and
atmospheric temperature
and pressure.
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Reference Application
Element

Description Variants

Longitudinal Driver
subsystem

Uses the Longitudinal
Driver block to generate
normalized acceleration and
braking commands based on
vehicle target and feedback
velocities.

 

Controllers subsystem Implements a powertrain
control module (PCM)
containing an input power-
split hybrid control module
(HCM) and an engine
control module (ECM).

✓

Passenger Car subsystem Implements a hybrid
passenger car that contains
drivetrain, electric plant,
and engine subsystems.

✓

Visualization subsystem Displays vehicle-level
performance, battery state
of charge (SOC), fuel
economy, and emission
results that are useful for
powertrain matching and
component selection
analysis.

 

Drive Cycle Source
The Drive Cycle Source block generates a target vehicle velocity for a selected or
specified drive cycle. The reference application has these options.

Timing Options Description
Output
sample time

Discrete Discrete operator commands
Continuous (default) Continuous operator commands
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Longitudinal Driver
The Longitudinal Driver subsystem generates normalized acceleration and braking
commands based on the target vehicle velocity. The reference application has these
options.

Filter Options Description
Low-pass
filter (LPF)

pass (default) Do not use a filter on velocity error.
LPF Use an LPF on target velocity error

for smoother driving.

Controllers
The Controller subsystem has a PCM containing an input power-split HCM and an
ECM. The controller has these variants.

Controller Variant Description
ECM SiEngineController (default) SI engine controller

CiEngineController CI engine controller
Input power
split HCM

Series Regen Brake (default) Friction braking provides the torque
not supplied by regenerative motor
braking.

Parallel Regen Braking Friction braking and regenerative
motor braking independently
provide the torque.

The input-power split HCM implements a dynamic supervisory controller that determines
the engine torque, generator torque, motor torque, and brake pressure commands.
Specifically, the input power-split HCM:

• Converts the driver accelerator pedal signal to a wheel torque request. The algorithm
uses the optimal engine torque and maximum motor torque curves to calculate the
total powertrain torque at the wheels.

• Converts the driver brake pedal signal to a brake pressure request. The algorithm
multiplies the brake pedal signal by a maximum brake pressure.

• Implements a regenerative braking algorithm for the traction motor to recover the
maximum amount of kinetic energy from the vehicle.
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• Implements a virtual battery management system. The algorithm outputs the dynamic
discharge and charge power limits as functions of battery SOC.

• Determines the vehicle operating mode through a set of rules and decision logic
implemented in Stateflow. The operating modes are functions of wheel speed and
requested wheel torque. The algorithm uses the wheel power request, accelerator
pedal, battery SOC, and vehicle speed rules to transition between electric vehicle (EV)
and HEV modes.

Mode Description
EV Traction motor provides the wheel torque request.
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Mode Description
HEV –
Charge
Sustaining
(Low
Power)

• Engine provides the wheel torque request.
• Torque blending algorithm transitions the torque production from

the EV motor to the HEV engine. The algorithm allows the motor
to ramp down the torque while the engine torque ramps up. Once
the blending is complete, the motor can start sustaining the
charge (negative torque), if needed.

• Based on the target battery SOC and available kinetic energy, the
HEV mode determines a charge sustain power level. The mode
includes the additional charge power in the engine power
command. To provide the desired charge power, the traction
motor acts as a generator.

• Depending on the instantaneous speeds of the engine and motor,
the generator may consume energy while regulating the engine
speed. In this case, the motor provides the additional charge
sustaining power.

HEV –
Charge
Depleting
(High
Power)

• Engine provides the wheel power request up to its maximum
output.

• If the wheel torque request is greater than the engine torque
output at the wheels, the traction motor provides the remainder
of the wheel torque request.

Stationary While the vehicle is at rest, the engine and generator can provide
optional charging if battery SOC is below a minimum SOC value.

• Controls the motor, generator, and engine through a set of rules and decision logic
implemented in Stateflow.
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Control Description
Engine • Decision logic determines the engine operation modes (off, start,

run).
• In engine run mode, lookup tables determine the engine torque

and engine speed that optimizes the break specific fuel
consumption (BSFC) for a given engine power request. The ECM
uses the optimal engine torque command. The generator control
uses the optimal engine speed command.

Generator • As determined by the HCM, the generator either starts the
engine or regulates the engine speed. To regulate the engine
speed, the generator uses a PI controller.

• A rule-based power management algorithm calculates a
generator torque that does not exceed the dynamic power limits.

Motor A rule-based power management algorithm calculates a motor
torque that does not exceed the dynamic power limits.

Passenger Car
To implement a passenger car, the Passenger Car subsystem contains drivertrain,
electric plant, and engine subsystems. To create your own engine variants for the
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reference application, use the CI and SI engine project templates. The reference
application has these variants.

Drivetrain
Subsystem

Variant Description

Vehicle Vehicle Body 3 DOF
Longitudinal

Configured for 3 degrees of freedom

Wheels and
Brakes

Longitudinal Wheel - Front For the wheels, you can configure
the type of:

• Brake
• Force calculation
• Resistance calculation
• Vertical motion

Longitudinal Wheel - Rear

Electric
Plant
Subsystem

Variant Description

Battery and
DC-DC
Converter

BattHevIps Configured with NiMH battery

Generator GenMapped (default) Mapped generator with implicit
controller

GenDynamic Interior permanent magnet
synchronous motor (PMSM) with
controller

Motor MotMapped (default) Mapped motor with implicit
controller

MotDynamic Interior permanent magnet
synchronous motor (PMSM) with
controller

Engine
Subsystem

Variant Description

Engine SiEngine Dynamic SI engine
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Engine
Subsystem

Variant Description

SiMappedEngine (default) Mapped SI engine
CiEngine Dynamic CI engine with

turbocharger
CiMappedEngine Mapped CI engine with implicit

turbocharger

References
[1] Balazs, A., Morra, E., and Pischinger, S., Optimization of Electrified Powertrains for

City Cars. SAE Technical Paper 2011-01-2451. Warrendale, PA: SAE International
Journal of Alternative Powertrains, 2012.

[2] Burress, T. A. et al, Evaluation of the 2010 Toyota Prius Hybrid Synergy Drive System.
Technical Report ORNL/TM-2010/253. U.S. Department of Energy, Oak Ridge
National Laboratory, March 2011.

[3] Rask, E., Duoba, M., Loshse-Busch, H., and Bocci, D., Model Year 2010 (Gen 3) Toyota
Prius Level-1 Testing Report. Technical Report ANL/ES/RP-67317. U.S.
Department of Energy, Argonne National Laboratory, September 2010.

See Also
CI Controller | CI Core Engine | Datasheet Battery | Drive Cycle Source | Interior PM
Controller | Interior PMSM | Longitudinal Driver | Mapped CI Engine | Mapped SI Engine
| SI Controller | SI Core Engine

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7
• “Explore the Hybrid Electric Vehicle Multimode Reference Application” on page 3-19

More About
• “Variant Systems” (Simulink)
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Resize the CI Engine
By default, the compression-ignition (CI) engine dynamometer reference application
engine is configured with a dynamic 1.5-L turbocharged diesel engine. Based on a desired
maximum engine power and the number of cylinders, you can resize the dynamic engine
(CiEngine) for different vehicle applications.

To resize the engines, use the dynamometer reference application. After you open the
reference application, click Resize Engine and Recalibrate Controller. In the dialog
box, enter values for:

• Desired maximum power
• Desired number of cylinders

After you apply the changes, the reference application:

• Resizes the dynamic engine and engine calibration parameters. The Recalibrate
Engine dialog box provides the updated engine performance characteristics based on
the resized calibration parameters.

• Recalibrates the controller and mapped engine model to match the resized dynamic
engine.

You can use the variants in other applications, for example, in vehicle projects that
require a larger engine model.

Create CI Engine Models with Twice the Power
1 If it is not already open, open a copy of the CI engine reference application project by

entering

autoblkCIDynamometerStart 

2 In the CiDynReferenceApplication model window, click Recalibrate Controller.

The reference application performs a dynamometer test to calibrate the engine
controller for the default 1.5-L turbocharged diesel engine. For engine speeds 2000–
5000 rpm, the measured engine torque approaches 240 N.m. The steady-state results
for measured engine torque as a function of torque command and engine speed are
similar to this plot.
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3 In the CiDynReferenceApplication model window, click Resize Engine and
Recalibrate Controller.

The dialog box opens with default values for Desired maximum power and Desired
number of cylinders. These values represent the calibration parameters for the
default 1.5-L dynamic engine.

The dialog box provides the calibration parameters for the current engine design.
The parameters are similar to these.
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4 In the Resize Engine and Recalibrate Controller dialog box, enter values that
represent approximately twice the maximum power and number of cylinders. For
example, set:

• Desired maximum power to 220.
• Desired number of cylinders to 8.

Click Resize Engine. The reference application:

• Resizes the dynamic engine (CiEngineCore) and engine calibration parameters.
The dialog box provides the updated engine performance characteristics based on
the resized calibration parameters.

• Recalibrates the controller (CiEngineController) and mapped engine model
(CiMappedEngine) to match the resized dynamic engine (CiEngineCore).

After resizing and recalibration, the dialog box provides the calibration parameters
for the resized engine. The parameters are similar to these.
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5 Examine the dynamometer steady-state results. For engine speeds 2000–5000 rpm,
the measured engine torque approaches 500 N.m. This result is approximately twice
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the power of the default dynamic engine. The steady-state results for measured
engine torque as a function of torque command and engine speed are similar to this
plot.

6 To save the engine controller, resized engine mapped variant, and resized dynamic
engine variant, in the CiDynReferenceApplication model window, save the
reference application.

By default, this process creates:

• An updated CI engine controller
• Two engine variants — mapped and dynamic

To see the parameters associated with the controller and engine variants:
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1 In MATLAB, use the PROJECT SHORTCUTS tab to open these models:

• CiEngineController
• CiMappedEngine
• CiEngineCore

2 Use the Model Explorer to view the resized parameters:

Engine
Model

Model Explorer

Controller —
CiEngineCon
troller
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Engine
Model

Model Explorer

Mapped —
CiMappedEng
ine

Dynamic —
CiEngineCor
e

3 In the CiDynoReferencApplication > Engine System > Engine Plant >
Engine > CIMappedEngine subsystem, open the Mapped CI Engine block. On the
Power tab, plot the actual torque as a function of engine speed and commanded fuel.
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See Also
CI Core Engine | Mapped CI Engine

More About
• “Explore the CI Engine Dynamometer Reference Application” on page 3-9
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Resize the SI Engine
By default, the spark-ignition (SI) engine dynamometer reference application engine is
configured with a 1.5-L dynamic gasoline engine. Based on a desired maximum engine
power and the number of cylinders, you can resize the dynamic engine (SiEngineCore)
for different vehicle applications.

To resize the engines, use the dynamometer reference application. After you open the
reference application, click Resize Engine and Recalibrate Controller. In the dialog
box, enter values for:

• Desired maximum power
• Desired number of cylinders

After you apply the changes, the reference application:

• Resizes the dynamic engine and engine calibration parameters. The Recalibrate
Engine dialog box provides the updated engine performance characteristics based on
the resized calibration parameters.

• Recalibrates the controller and mapped engine model to match the resized dynamic
engine.

You can use the variants in other applications, for example, in vehicle projects that
require a larger engine model.

Create SI Engine Models with Twice the Power
1 If it is not already open, open a copy of the SI engine reference application project by

entering

autoblkSIDynamometerStart 

2 In the SiDynReferenceApplication model window, click Recalibrate Controller.

The reference application performs a dynamometer test to calibrate the engine
controller for the default 1.5-L dynamic engine. For engine speeds 2000–5000 rpm,
the measured engine torque approaches 180 N.m. The steady-state results for
measured engine torque as a function of torque command and engine speed are
similar to this plot.
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3 In the SiDynReferenceApplication model window, click Resize Engine and
Recalibrate Controller.

The dialog box opens with default values for Desired maximum power and Desired
number of cylinders. These values represent the calibration parameters for the
default 1.5-L dynamic engine.

The dialog box provides the calibration parameters for the current engine design.
The parameters are similar to these.
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4 In the Resize Engine and Recalibrate Controller dialog box, enter values that
represent approximately twice the maximum power and number of cylinders. For
example, set:

• Desired maximum power to 230.
• Desired number of cylinders to 8.

Click Resize Engine. The reference application:

• Resizes the dynamic engine (SiEngineCore) and engine calibration parameters.
The Recalibrate Engine dialog box provides the updated engine performance
characteristics based on the resized calibration parameters.

• Recalibrates the controller (SiEngineController) and mapped engine model
(SiMappedEngine) to match the resized dynamic engine (SiEngineCore).

After resizing and recalibration, the dialog box provides the calibration parameters
for the resized engine. The parameters are similar to these.
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5 Examine the dynamometer steady-state results. For engine speeds 2000–5000 rpm,
the measured engine torque approaches 350 N.m. This result is approximately twice
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the power of the default dynamic engine. The steady-state results for measured
engine torque as a function of torque command and engine speed are similar to this
plot.

6 To save the engine controller, resized engine mapped variant, and resized dynamic
engine variant, in the SiDynReferenceApplication model window, save the
reference application.

By default, this process creates:

• An updated SI engine controller
• Two engine variants — mapped and dynamic

To see the parameters associated with the controller and engine variants:

3 Reference Applications

3-50



1 In MATLAB, use the PROJECT SHORTCUTS tab to open these models:

• SiEngineController
• SiMappedEngine
• SiEngineCore

2 Use the Model Explorer to view the resized parameters:

Engine
Model

Model Explorer

Controller —
SiEngineCon
troller
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Engine
Model

Model Explorer

Mapped —
SiMappedEng
ine

Dynamic —
SiEngineCor
e

3 In the SiDynoReferencApplication > Engine System > Engine Plant >
Engine > SIMappedEngine subsystem, open the Mapped SI Engine block. On the
Power tab, plot the actual torque as a function of engine speed and commanded
torque.
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See Also
Mapped SI Engine | SI Core Engine

More About
• “Explore the SI Engine Dynamometer Reference Application” on page 3-14
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Generate Mapped CI Engine from a Spreadsheet
If you have the Model-Based Calibration Toolbox, you can use the engine dynamometer
reference application to generate lookup tables for the Mapped CI Engine block. The
reference application uses engine data to calibrate the engine and generate the tables.

1 If it is not opened, open the reference application.

autoblkCIDynamometerStart 

2 Click Generate Mapped Engine from Spreadsheet.

Step 1: Generate Mapped Engine Calibration
1 Use the Spreadsheet file field to provide a data file. By default, the reference

application has CiEngineData.xlsx containing required and optional data. The
tables summarize the data file requirements for generating calibrated tables that are
functions of either injected fuel mass or engine torque and engine speed.

Note To specify the lookup table type, in the Mapped CI Engine block, set the Input
command parameter to Fuel mass or Torque.

Firing data contains data collected at different engine torques and speeds.

Firing Data Description Data Requirements for Generating
Mapped Engine Tables
Function of Fuel
Mass and Engine
Speed

Function of Torque
and Engine Speed

FuelMassCm
d

Injected fuel mass, in
mg/inj

Required Not used

Torque Engine torque
command, in N·m

Required Required

EngSpd Engine speed, in rpm Required Required
AirMassFlwR
ate

Air mass flow, in kg/s Optional Optional
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Firing Data Description Data Requirements for Generating
Mapped Engine Tables
Function of Fuel
Mass and Engine
Speed

Function of Torque
and Engine Speed

FuelMassFlw
Rate

Fuel mass flow, in
kg/s

Optional Optional

ExhTemp Exhaust temperature,
in K

Optional Optional

BSFC Engine brake-specific
fuel consumption
(BSFC), in g/kWh

Optional Optional

HCMassFlwR
ate

Hydrocarbon
emission mass flow,
in kg/s

Optional Optional

COMassFlwR
ate

Carbon monoxide
emission mass flow,
in kg/s

Optional Optional

NOxMassFlw
Rate

Nitric oxide and
nitrogen dioxide
emissions mass flow,
in kg/s

Optional Optional

CO2MassFlw
Rate

Carbon dioxide
emission mass flow,
in kg/s

Optional Optional

PMMassFlwR
ate

Particulate matter
emission mass flow,
in kg/s

Optional Optional

Nonfiring data contains data collected at different engine speeds without fuel
consumption.
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Nonfiring
Data

Description Data Requirements for Generating
Mapped Engine Tables
Function of Fuel
Mass and Engine
Speed

Function of Torque
and Engine Speed

FuelMassCmd Injected fuel mass,
in mg/inj

Not used Not used

Torque Engine torque
command, in N·m

Required Required

EngSpd Engine speed, in
rpm

Required Required

AirMassFlwR
ate

Air mass flow, in
kg/s

Optional Optional

2 Click Generate mapped engine calibration to generate response surface models in
the Model-Based Calibration Toolbox and calibration in CAGE (CAlibration
GEneration). CAGE and the model browser open when the process completes. To
calibrate the data, Model-Based Calibration Toolbox uses templates.

• The Model Browser provides the response model fits for the data contained in the
data file, for example:
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• The CAGE Browser provides the calibrated data, for example:
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Step 2: Apply Calibration to Mapped Engine Model
When you click Apply calibration to mapped engine model, Powertrain Blockset:

• Updates the Mapped CI Engine block parameters with the calibrated table and
breakpoint data.

• Updates the CI Controller with the fuel mass per injection table if the Mapped CI
Engine block tables are functions of fuel mass and engine speed.
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• Sets the Mapped CI Engine as the active variant.
• Executes the engine mapping experiment.

When the dynamometer engine mapping completes, use the Performance Monitor to
verify the results.

See Also
CI Controller | CI Core Engine | Mapped CI Engine

More About
• “Explore the CI Engine Dynamometer Reference Application” on page 3-9
• “What Is CAGE?” (Model-Based Calibration Toolbox)
• “Mapped CI Lookup Tables as Functions of Fuel Mass and Engine Speed” (Model-

Based Calibration Toolbox)
• “Mapped CI Lookup Tables as Functions of Engine Torque and Speed” (Model-Based

Calibration Toolbox)

 See Also
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Generate Mapped SI Engine from a Spreadsheet
If you have the Model-Based Calibration Toolbox, you can use the engine dynamometer
reference application to generate lookup tables for the Mapped SI Engine block. The
reference application uses engine data to calibrate the engine and generate the tables.

1 If it is not opened, open the reference application.

autoblkSIDynamometerStart 

2 Click Generate Mapped Engine from Spreadsheet.

Step 1: Generate Mapped Engine Calibration
1 Use the Spreadsheet file field to provide a data file. By default, the reference

application has SiEngineData.xlsx containing required and optional data. The
tables summarize the data file requirements for generating calibrated tables that are
functions of either injected fuel mass or engine torque and engine speed.

Firing data contains data collected at different engine torques and speeds.

Firing Data Description Data Requirements for
Generating Mapped
Engine Tables

FuelMassCmd Injected fuel mass, in mg/inj Not Used
Torque Engine torque command, in

N·m
Required

EngSpd Engine speed, in rpm Required
AirMassFlwRate Air mass flow, in kg/s Optional
FuelMassFlwRate Fuel mass flow, in kg/s Optional
ExhTemp Exhaust temperature, in K Optional
BSFC Engine brake-specific fuel

consumption (BSFC), in
g/kWh

Optional

HCMassFlwRate Hydrocarbon emission mass
flow, in kg/s

Optional
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Firing Data Description Data Requirements for
Generating Mapped
Engine Tables

COMassFlwRate Carbon monoxide emission
mass flow, in kg/s

Optional

NOxMassFlwRate Nitric oxide and nitrogen
dioxide emissions mass flow,
in kg/s

Optional

CO2MassFlwRate Carbon dioxide emission
mass flow, in kg/s

Optional

PMMassFlwRate Particulate matter emission
mass flow, in kg/s

Optional

Nonfiring data contains data collected at different engine speeds without fuel
consumption.

Nonfiring Data Description Data Requirements for
Generating Mapped
Engine Tables

FuelMassCmd Injected fuel mass, in mg/inj Not used
Torque Engine torque command, in

N·m
Required

EngSpd Engine speed, in rpm Required
AirMassFlwRate Air mass flow, in kg/s Optional

2 Click Generate mapped engine calibration to generate response surface models in
the Model-Based Calibration Toolbox and calibration in CAGE (CAlibration
GEneration). CAGE and the model browser open when the process completes. To
calibrate the data, Model-Based Calibration Toolbox uses templates.

• The Model Browser provides the response model fits for the data contained in the
data file, for example:
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• The CAGE Browser provides the calibrated data, for example:
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Step 2: Apply Calibration to Mapped Engine Model
When you click Apply calibration to mapped engine model, Powertrain Blockset:

• Updates the Mapped SI Engine block parameters with the calibrated table and
breakpoint data.

• Sets the Mapped SI Engine as the active variant.
• Executes the engine mapping experiment.

When the dynamometer engine mapping completes, use the Performance Monitor to
verify the results.

See Also
Mapped SI Engine | SI Core Engine
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More About
• “Explore the SI Engine Dynamometer Reference Application” on page 3-14
• “What Is CAGE?” (Model-Based Calibration Toolbox)
• “Mapped SI Lookup Tables as Functions of Engine Torque and Speed” (Model-Based

Calibration Toolbox)
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Internal Combustion Mapped and Dynamic Engine
Models

When you customize a SI or CI reference application, you can use either a dynamic or
mapped engine model. The table provides considerations for using either implementation.

Type Implementation When to Use
Mapped CiMappedEng

ine

SiMappedEng
ine

Model uses a set of steady-
state lookup tables to
characterize engine
performance.

The tables provide overall
engine characteristics,
including actual torque, fuel
flow rate, BSFC, and engine-
out exhaust emissions.

• If you have engine data
from a dynamometer or a
design tool like GT-
POWER.

• For quasi steady-state
engine simulations.

Dynamic CiEngine

SiEngine

Model decomposes the engine
behavior into engine
characteristics that are
separated into lower-level
components. By combining
components in this way, the
models capture the dynamic
effects.

• If you need a more
detailed dynamic model
and have component-level
data.

• To analyze the impact of
individual engine
components on the overall
performance.

See Also

More About
• Mapped CI Engine
• Mapped SI Engine
• CI Core Engine
• SI Core Engine
• “Engine Calibration Maps” on page 2-41
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CI Engine Project Template
The Powertrain Blockset software provides a project template for compression-ignition
(CI) engines. Use the template to create engine variants that you can use with the
internal combustion engine reference application projects. To open the project template,
see “Create CI and SI Engines Using Project Templates” on page 4-7. The project
template contains CI engine controller and plant models.

Use the project template to create CI engine variants for these reference applications:

• Conventional vehicle
• Hybrid electric vehicle
• CI engine dynamometer

Controller
The Controller folder contains the CiEngineController.slx model. The model uses
the CI Controller block and a Start Stop Logic subsystem to control the CI engine
plant model.

Plant
The Plant folder contains models that represent dynamic and mapped CI engines. By
default, the dynamic and mapped engines are configured for a 1.5–L engine with a
variable geometry turbocharger (VGT).

Dynamic

CiEngineCore.slx contains the engine intake system, exhaust system, exhaust gas
recirculation (EGR), fuel system, core engine, and turbocharger subsystems.
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Mapped

CiMappedEngine.slx uses the Mapped CI Engine block to look up power, air mass flow,
fuel flow, exhaust temperature, efficiency, and emission performance as functions of
engine speed and injected fuel mass.

See Also
CI Controller | CI Core Engine | Mapped CI Engine

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7
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More About
• “Internal Combustion Engine Reference Application Projects” on page 3-2
• “Variant Systems” (Simulink)
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SI Engine Project Template
The Powertrain Blockset software provides a project template for spark-ignition (SI)
engines. Use the template to create engine variants that you can use with the internal
combustion engine reference application projects. To open the project template, see
“Create CI and SI Engines Using Project Templates” on page 4-7. The project template
contains SI engine controller and plant models.

Use the project template to create CI engine variants for these reference applications:

• Conventional vehicle
• Hybrid electric vehicle
• SI engine dynamometer

Controller
The Controller folder contains the SiEngineController.slx model. The model uses
the SI Controller block and a Start Stop Logic subsystem to control the SI engine
plant model.

Plant
The Plant folder contains models that represent dynamic and mapped SI engines. By
default, the dynamic and mapped engines are configured for a 1.5–L turbocharged
engine.

Dynamic

SiEngineCore.slx contains the engine intake system, exhaust system, core engine, and
turbocharger subsystems.
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Mapped

SiMappedEngine.slx uses the Mapped SI Engine block to look up power, air mass flow,
fuel flow, exhaust temperature, efficiency, and emission performance as functions of
engine speed and commanded torque.

See Also
Mapped SI Engine | SI Controller | SI Core Engine

Related Examples
• “Create CI and SI Engines Using Project Templates” on page 4-7

More About
• “Internal Combustion Engine Reference Application Projects” on page 3-2
• “Variant Systems” (Simulink)
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Create CI and SI Engines Using Project Templates
The Powertrain Blockset software provides project templates for compression-ignition
(CI) and spark-ignition (SI) engines. Use the templates to create engine variants that you
for the reference application projects.

1 In Simulink, select File > New > Project.

In the Simulink start page, browse to Powertrain Blockset and select CI Engine or SI
Engine.

2 In Simulink Project, in Project name, enter a project name, for example,
CIengineProject.

3 In Project folder, enter a project folder or browse to the folder to save the project,
for example, CIengineProjectFolder.

4 Click Create Project.

If the folder does not exist, the dialog box prompts you to create it. Click Yes.

The software compiles the project and populates the project folders. All models and
supporting files are in place for you to customize your CI or SI engine model.

See Also

More About
• “Internal Combustion Engine Reference Application Projects” on page 3-2
• “CI Engine Project Template” on page 4-2
• “SI Engine Project Template” on page 4-5
• Simulink Projects (Simulink)
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Install Drive Cycle Data
This example shows how to install additional drive cycle data for the Drive Cycle Source
block. By default, the block has the FTP-75 drive cycle data. The support package has
drive cycles that include the gear shift schedules, for example JC08 and CUEDC.

1 In the Drive Cycle Source block, click Install additional drive cycles to start the
installer.

2 Follow the instructions and default settings provided by the installer to complete the
installation.

3 On the Select a support package screen, select the data you want to add:

Accept or change the Installation folder and click Next.

Note You must have write privileges for the Installation folder.

See Also
Drive Cycle Source
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Generate Parameter Data for Datasheet Battery Block
This example shows how to import lithium-ion battery sheet data and generate
parameters for the Datasheet Battery block. To run the example, you need the Curve
Fitting Toolbox™.

In step 1, you import the datasheet data. Steps 2-5 show how to use curve-fitting
techniques to obtain the open circuit voltage and battery resistance from the datasheet
data. In steps 6-8, you validate the curve-fit voltage and battery values by comparing
them to the Arrhenius behavior and the datasheet data. Finally, in step 9, you specify
these Datasheet Battery block parameters:

• Rated capacity at nominal temperature
• Open circuit voltage table data
• Open circuit voltage breakpoints 1
• Internal resistance table data
• Battery temperature breakpoints 1
• Battery capacity breakpoints 2
• Initial battery charge

Step 1: Import Battery Datasheet Data

Import the battery discharge and temperature datasheet into MATLAB. Ensure that each
dataset in the datasheet includes a starting battery cell output voltage. Typically, data
collected at different temperatures has the same reference current. Data collected at
different currents has the same reference temperature.

For this example, load the battery datasheet discharge and temperature data for a
lithium-ion battery from a file that contains 12 data sets. Each data set corresponds to
battery data for a specific current and temperature. The data sets each have two columns.
The first column contains the discharge capacity, in percent. The second column contains
the corresponding battery cell voltage.

exp_data=load(fullfile(matlabroot,'examples','autoblks','ex_datasheetbattery_liion_100Ah.mat'));

The example does not use the data set that corresponds to a current of 500 A at 25 ºC.

Plot the discharge and temperature curves. Figure 1 shows the lithium-ion battery
discharge characteristics at constant temperature (at five levels of current, shown as C-
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rate) and constant current (at six temperatures). Figure 1 indicates the curve that
corresponds to the reference temperature of 25 ºC and the reference current of 50 A.

ex_datasheetbattery_plot_data

Step 2: Normalize State-of-Charge (SOC) Data

To represent 1-SOC capacity at constant temperature, normalize the relative discharge
capacity with values between 0 and 1. Let 1 represent a fully discharged battery.

Set ref_exp to the dataset that corresponds to the reference temperature of 25 °C and
the reference current of 50 A. Typically, the reference temperature is room temperature.

ref_exp = 2;
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If you have several data sets, use a few for validation. Do not include them as part of the
estimation dataset.

For this example, use val_exp to set up the validation and estimation data sets. Let 1
represent a validation dataset and 0 represent an estimation dataset.

val_exp = logical([1 0 0 0 1 0 0 0 0 1 0]);

Define reference current and temperature. For this example, the reference temperature is
25 °C and the reference current is 50 A.

ref_curr = current == current(ref_exp);
ref_temp = temperature == temperature(ref_exp);

[sort_current, sort_index_current] = sort(current(ref_temp));
[sort_temp, sort_index_temp] = sort(temperature(ref_curr));
N = length(current); % Number of experiments

Prepare normalized x axes for each data set and find the actual capacity. x is a structure
with as many fields as data sets and values between 0 and 1.

for i=1:N
    x.(['curr' current_label{i} '_temp' temperature_label{i}]) = ...
            exp_data.([label '_' current_label{i} '_' temperature_label{i}])(:,1)/...
            exp_data.([label '_' current_label{i} '_' temperature_label{i}])(end,1);
    % Calculate actual capacity for each datasheet
    correct_cap.(['curr' current_label{i} '_temp' temperature_label{i}]) = ...
            exp_data.([label '_' current_label{i} '_' temperature_label{i}])(end,1);
end

Plot the normalized SOC data.

ex_datasheetbattery_plot_soc
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Step 3: Fit Curves

Create fitObj curves for constant temperatures at different discharge rates and
constant discharge rates at different temperatures. Use the fitObj curves to create a
matrix of cell/module voltage versus discharge current at varying levels of SOC.

fitObj is a structure of fit objects that contains as many fields as data sets. The
structure fits a discharge voltage to the normalized ([0,1]) extracted Ah. This allows
the discharge curves to be algebraically combined to calculate resistance at each SOC
level.

Define state of charge vector and breakpoints.
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SOC_LUT = (0:.01:1)';
SOCbkpts = 0:.2:1;

Fit the discharge curves at different currents for reference temperature.

for i=find(ref_temp)
    fitObj.(['fit' current_label{i}]) = ...
        fit(x.(['curr' current_label{i} '_temp' temperature_label{i}]),...
        exp_data.([label '_' current_label{i} '_' temperature_label{ref_exp}])(:,2),'smoothingspline');
end

Fit the discharge curves at different temperatures for reference current.

for i=find(ref_curr)
    fitObj.(['fit' temperature_label{i}]) = ...
        fit(x.(['curr' current_label{i} '_temp' temperature_label{i}]),...
        exp_data.([label '_' current_label{ref_exp} '_' temperature_label{i}])(:,2),'smoothingspline');
end

Construct the voltage versus discharge current for different SOC levels. Em_MAT is a
matrix with the SOC in rows and the current in columns.

Em_MAT = [];
for i=find(ref_temp)
    Em_MAT = [Em_MAT fitObj.(['fit' current_label{i}])(SOC_LUT)];
end

Figure 3 shows the voltage versus current at different SOCs.

ex_datasheetbattery_plot_curves
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Step 4: Extrapolate Open Circuit Voltage

To obtain the open circuit voltage, Em , fit a line to the voltage versus current curve and
extrapolate to i=0 .

R0_refTemp = [];
for i=1:length(SOC_LUT)
    % Fit a line to V=f(I)
    fitSOC.(['SOC' num2str(i)]) = fit(sort_current',Em_MAT(i,sort_index_current)','poly1');
end

To estimate open circuit voltage, Em , at all SOC levels, extrapolate the values of voltage
to i=0 .
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Em = [];
for i=1:length(SOC_LUT)
    % Em = f(0)
    Em = [Em fitSOC.(['SOC' num2str(i)])(0)];
end
Em = Em';

Step 5: Determine Battery Voltage and Resistance at Different Temperatures

Use the discharge and temperature data to determine the battery resistance as a function
of current and SOC at varying temperatures. The validation data is not included. Figure 4
shows the battery voltage at different temperatures.

ex_datasheetbattery_plot_voltage
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Calculate the resistance at different temperatures using the reference current data set.

R0_LUT = [];
for i=find(ref_curr & ~val_exp)
    % Create fit object for V vs. SOC
    voltVsSOC.(['temp' temperature_label{i}]) = fitObj.(['fit' temperature_label{i}])(SOC_LUT);
    % Calculate R0(SOC,T) assuming linear behavior R0 = DeltaV / I
    R0.(['temp' temperature_label{i}]) = (Em - voltVsSOC.(['temp' temperature_label{i}]))./current(ref_exp);
    % Construct LUT
    R0_LUT = [R0_LUT R0.(['temp' temperature_label{i}])];
end

To avoid the abrupt R change close to SOC=0 , extend R(0.9) all the way up to R(1). This is
needed because of the way R is calculated. Make algorithm robust in case 0.9 is not an
actual breakpoint

if ~isempty(find(SOC_LUT==0.9, 1))
    R0_LUT(SOC_LUT>0.9,:) = repmat(R0_LUT(SOC_LUT == 0.9,:),length(R0_LUT(SOC_LUT>0.9,:)),1);
else
    [closestTo0p9, locClosestTo0p9] = min(abs(SOC_LUT-0.9));
    R0_LUT(SOC_LUT>closestTo0p9,:) = repmat(R0_LUT(locClosestTo0p9,:),...
                                     length(R0_LUT(SOC_LUT>closestTo0p9,:)),1);
end

Determine the battery resistance at different temperatures.

R0_LUT = max(R0_LUT,0);
T_LUT = 273.15 + temperature(ref_curr & ~val_exp);
[T_LUT1,idx] = sort(T_LUT);
xtmp=R0_LUT';
R0_LUT1(1:length(T_LUT),:) = xtmp(idx,:);

Figure 5 shows the battery resistance at different temperatures.

ex_datasheetbattery_plot_resistance
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Step 6: Compare to Arrhenius Behavior

Since the temperature-dependent reaction rate for the lithium-ion battery follows an
Arrhenius behavior, you can use a comparison to validate the curve fit.

To determine the curve-fit prediction for the Arrhenius behavior, examine the activation
energy, Ea . Obtain the activation energy via the slope of the internal resistance, Ro ,
versus 1000/T curve for different SOCs. The slope equals the activation energy, Ea ,
divided by the universal gas constant, Rg .

For a lithium-ion battery, a typical value of Ea is 20 kJ/mol[2]. Figure 6 indicates that the
activation energy, Ea , obtained via the slope compares closely with 20 kJ/mol.

ex_datasheetbattery_plot_arrhenius
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Activation energy for Li ion conduction
Ea = 17.9958       20.669      18.9557      22.8107      21.5289      24.0987 kJ/mol
Ea for electrolyte transport in Li ion battery = 20 kJ/mol

Step 7: Fit Battery Resistance

Fit the battery resistance to the validated temperature data as a function of SOC and
temperature.

R0_LUT_bkpts = [];
counter = 1;
for i=find(ref_curr & ~val_exp)
    R0_LUT_bkpts = [R0_LUT_bkpts R0_LUT(idx',counter)];
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    counter = counter+1;
end

[xx,yy,zz] = prepareSurfaceData(1000./T_LUT,SOCbkpts,log(R0_LUT_bkpts));
[R0_vs_T_SOC_fit, gof] = fit([xx,yy],zz,'linearinterp');
% [R0_vs_T_SOC_fit, gof] = fit([xx,yy],zz,'poly12');
[xx1,yy1,zz1] = prepareSurfaceData(T_LUT,SOCbkpts,R0_LUT_bkpts);
[R0_vs_T_SOC_fit1, gof] = fit([xx1,yy1],zz1,'linearinterp');

Figures 7 and 8 show the surface plots of the battery resistance as a function of SOC and
temperature.

ex_datasheetbattery_plot_surface
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Step 8: Validate Battery Model Fit

Figure 9 shows the calculated data and the experimental data set data.

ex_datasheetbattery_plot_validation
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Step 9: Set the Datasheet Battery Block Parameters

Set the Rated capacity at nominal temperature parameter to the capacity provided by
the datasheet.

BattChargeMax = 100; % Ah Capacity from datasheet

Set the Open circuit voltage table data parameter to Em.

Em=Em;

Set the Open circuit voltage breakpoints 1 parameter to the state of charge vector.

CapLUTBp=SOC_LUT;
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Set the Internal resistance table data parameter to the fitted battery resistance data
as a function of SOC and temperature.

RInt=R0_LUT_bkpts;

Set the Battery temperature breakpoints 1 parameter to the temperature vector.

BattTempBp=T_LUT1;

Set the Battery capacity breakpoints 2 parameter to the SOC vector.

CapSOCBp=SOCbkpts;

Set the Initial battery charge parameter to the value provided by the datasheet.

BattCapInit=100;

Clean up.

clear x xx xx1 yy yy1 zz zz1;
clear batt_id col correct cap count counter current;
clear correct_cap current_label data exp_data fitObj fitSOC gof;
clear i I idx indicot j k label leg line_colors;
clear indigo N orange p1 p2 purple ref_curr ref_exp ref_temp row;
clear sort_current sort_index_current sort_index_temp sort_temp;
clear temperature temperature_lable V val_exp valIdx voltVsSOC xtmp temperature_label;
clear Ea Em_MAT markerType1 R0 R0_LUT R0_LUT1 R0_LUT_bkpts R0_refTemp R0_vs_T_fit;
clear T R R0_vs_T_SOC_fit R0_vs_T_SOC_fit1 SOC_LUT SOCbkpts T_LUT T_LUT1;

References

[1] Jackey, Robyn, Tarun Huria, Massimo Ceraolo, and Javier Gazzarri. "High fidelity
electrical model with thermal dependence for characterization and simulation of high
power lithium battery cells." IEEE International Electric Vehicle Conference. March 2012,
pp. 1-8.

[2] Ji, Yan, Yancheng Zhang, and Chao-Yang Wang. Journal of the Electrochemical Society.
Volume 160, Issue 4 (2013), A636-A649.
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Generate Parameter Data for Equivalent Circuit Battery
Block

Using MathWorks tools, estimation techniques, and measured lithium-ion or lead acid
battery data, you can generate parameters for the Equivalent Circuit Battery block. The
Equivalent Circuit Battery block implements a resistor-capacitor (RC) circuit battery with
open circuit voltage, series resistance, and 1 through N RC pairs. The number of RC pairs
reflects the number of time constants that characterize the battery transients. Typically,
the number of RC pairs ranges from 1 through 5.

To create parameter data for the Equivalent Circuit Battery block, follow these workflow
steps. The steps use numerical optimization techniques to determine the number of
recommended RC pairs, provide initial estimates for the battery model circuit
parameters, and estimate parameters to fit a model to experimental pulse discharge data.
The results provide the open circuit voltage, series resistance, and RC pair parameter
data for the Equivalent Circuit Battery block.

The workflow steps use this example script and models for a lithium-ion polymer (LiPo)
battery:

• Estimate battery discharge script Example_DischargePulseEstimation.
• Model BatteryEstim3RC_PTBS.
• Model BatteryEstim3RC_PTBS_EQ.

The example battery discharge script uses a battery class to control the parameter
estimation workflow.

Workflow Description Additional MathWorks
Tooling

“Step 1: Load and
Preprocess Data” on page
6-17

Load and preprocess time
series battery discharge
voltage and current data.

None

“Step 2: Determine the
Number of RC Pairs” on
page 6-20

Determine the number of
necessary time constants (TC)
for estimation.

Curve Fitting Toolbox
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matlab:open('Example_DischargePulseEstimation.m')
matlab:open('BatteryEstim3RC_PTBS.slx')
matlab:open('BatteryEstim3RC_PTBS_EQ.slx')


Workflow Description Additional MathWorks
Tooling

“Step 3: Estimate
Parameters” on page 6-
21

For battery discharge data,
estimate and optimize:

• Open-circuit voltage, Em
• Series resistance, R0
• RC pair(s) time

constant(s), Tau
• RC pair(s) resistance(s), Rx

Use a model that exercises
the Estimation Equivalent
Circuit Battery block.

Curve Fitting Toolbox, Parallel
Computing Toolbox,
Optimization Toolbox, and
Simulink Design Optimization

“Step 4: Set Equivalent
Circuit Battery Block
Parameters” on page 6-
27

Set these block parameters:

• Open circuit voltage
table data

• Series resistance table
data

• State of charge
breakpoints

• Temperature
breakpoints

• Battery capacity table
• Network resistance

table data
• Network capacitance

table data

None

Step 1: Load and Preprocess Data
Data Format and Requirements

The workflow supports pulse discharge sequences from 100% to 0% state-of-charge
(SOC).
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Data requirements include:

• Time series consisting of current and voltage from an experimental pulse discharge.
For each experimental data set, the temperature is constant. The sample rate should
be a minimum of 1 Hz, with an ideal rate at 10 Hz. This table summarizes the accuracy
requirements.

Measurement Accuracy Ideal
Voltage ±5 mV ±1 mV
Current ±100 mA ±10 mA
Temperature ±1 °C ±1 °C

• Change in SOC for each pulse should not be greater than 5%.
• Data collection at high or low SOC might need modification to ensure safety.
• Sufficient relaxation time after each pulse to ensure battery approaches steady-state

voltage.

Load and Preprocess Data

Load the battery time, voltage, and discharge data. Break up the data into
Battery.Pulse objects. For example, load and preprocess the discharge data for a
lithium-ion polymer (LiPo) battery using the Step1: Load and Preprocess Data
commands in the Example_DischargePulseEstimation script.
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Pulse Sequence
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Pulse Identification

Step 2: Determine the Number of RC Pairs
Determine how many RC pairs to use in the model. You can investigate how many RC
pairs to use by executing the Step 2: Determine the Number of RC Pairs
commands in the Example_DischargePulseEstimation script. The example script
uses the BatteryEstim3RC_PTBS model.

Compare Pulse Time Constants

Compare the time constants (TC) for each pulse. This example compares three pulses.
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TC Comparison, Pulse 3 of 3

Step 3: Estimate Parameters
Estimate the parameters. You can investigate parameter estimation by executing the
Step 3: Estimate Parameters commands in the
Example_DischargePulseEstimation script.

Estimate Em and R0

Inspect the voltage immediately before and after the current is applied and removed at
the start and end of each pulse. The estimation technique uses the voltage for a raw
calculation to estimate the open-circuit voltage (Em) and the series resistance (R0).
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Parameter Tables

Estimate Tau

Use a curve-fitting technique on the pulse relaxation to estimate the RC time constant
(Tau) at each SOC.
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Relaxation Tau Fit

Plot Estimates

Plot the parameter and pulse sequence data and simulation comparison.
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Parameter Tables
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Pulse Sequence

Identify Parameters and Set Initial Values

Identify parameters and set the initial values using a linear system approach, pulse-by-
pulse.
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Linear Fit

Optimize Estimates

Optimize the Em, R0, Rx, and Tau estimates using Simulink Design Optimization.
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Pulse Identification

Step 4: Set Equivalent Circuit Battery Block Parameters
Set the Equivalent Circuit Battery block parameters to the values determined in step 3. To
investigate setting the block parameters, execute the Step 4: Set Equivalent
Circuit Battery Block Parameters commands in the
Example_DischargePulseEstimation script. The experiment ran at two constant
temperatures. There are three RC-pairs. The Equivalent Circuit Battery block parameter
values are summarized in this table:
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Parameter Example Value
Number of series RC pairs 3
Open circuit voltage table data, EM EmPrime = repmat(Em,2,1)';

Series resistance table data, R0 R0Prime = repmat(R0,2,1)';

State of charge breakpoints, SOC_BP SOC_LUTPrime = SOC_LUT;

Temperature breakpoints,
Temperature_BP

TempPrime = [303 315.15];

Battery capacity table CapacityAhPrime = [CapacityAh CapacityAh];

Network resistance table data, R1 R1Prime = repmat(Rx(1,:),2,1)';

Network capacitance table data, C1 C1Prime = repmat(Tx(1,:)./Rx(1,:),2,1)';

Network resistance table data, R2 R2Prime = repmat(Rx(2,:),2,1)';

Network capacitance table data, C2 C2Prime = repmat(Tx(2,:)./Rx(2,:),2,1)';

Network resistance table data, R3 R3Prime = repmat(Rx(3,:),2,1)';

Network capacitance table data, C3 C3Prime = repmat(Tx(3,:)./Rx(3,:),2,1)';
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Generate Parameters for Flux-Based Blocks
This table provides a description of the process to generate the parameters and links to
examples.

For Block To Generate Description Example
Flux-Based PM
Controller

Current Controller
parameters:

• Corresponding
d-axis current
reference, id_ref

• Corresponding
q-axis current
reference, iq_ref

• Vector of speed
breakpoints,
wbp

• Vector of torque
breakpoints, tbp

Use the Model-Based
Calibration Toolbox
to generate
optimized current
controller tables for
flux-based motor
controllers.

Based on nonlinear
motor flux data, the
calibration tables
optimize:

• Motor efficiency
• Maximum torque

per ampere
(MTPA)

• Flux weakening

“Generate Current
Controller
Parameters” on page
6-33
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For Block To Generate Description Example
Motor parameters:

• Vector of d-axis
current
breakpoints,
id_index

• Vector of q-axis
current
breakpoints,
iq_index

• Corresponding
d-axis flux,
lambda_d

• Corresponding
q-axis flux,
lambda_q

Use MATLAB scripts
available with
Powertrain Blockset
to load flux motor
data, visualize the
flux surface, and
create plots of flux as
a function of current.

“Generate Feed-
Forward Flux
Parameters” on page
6-60

Flux-Based PMSM Parameters:

• Vector of d-axis
flux, flux_d

• Vector of q-axis
flux, flux_q

• Corresponding
d-axis current,
id

• Corresponding
q-axis current,
iq

Use MATLAB scripts
available with
Powertrain Blockset
to load flux motor
data, invert the flux,
and create plots of
current as a function
of flux.

“Generate
Parameters for Flux-
Based PMSM Block”
on page 6-65

To open a model with optimized parameters for the Flux-Based PM Controller and Flux-
Based PMSM blocks, on the command-line, type Flux_Based_PMSM_TestBench.
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matlab:open('Flux_Based_PMSM_TestBench.slx')
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Generate Current Controller Parameters
Using the Model-Based Calibration Toolbox, you can generate optimized current tables
for flux-based motor controllers. Use the calibration tables for the Powertrain Blockset
Flux-Based PM Controller current controller block parameters.

Based on nonlinear motor flux data, the calibration tables optimize:

• Motor efficiency
• Maximum torque per ampere (MTPA)
• Flux weakening

To generate optimized current tables, follow these workflow steps.

Workflow Steps Description MathWorks Tooling
“Collect and Post Process
Motor Data” on page 6-34

Collect the nonlinear motor flux
data from dynamometer testing
or finite element analysis (FEA).
For this example, file
ex_motor_data.xlsx contains
the data that you need:

• d-axis current, Id, in A
• q-axis current, Iq, in A
• Motor speed, n, in rpm
• d-axis voltage, Vd, in V
• q-axis voltage, Vq, in V
• Electromagnetic motor

torque, Te, in N.m

N/A

“Model Motor Data” on page
6-35

Use a one-stage model to fit the
data. Specifically:

• Import data
• Filter data
• Fit model

Model-Based
Calibration Toolbox
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Workflow Steps Description MathWorks Tooling
“Generate Calibration” on
page 6-40

Calibrate and optimize the data
using objectives and constraints.
Specifically:

• Create functions.
• Create tables from model.
• Run an optimization.
• Generate and fill optimized

current controller calibration
tables that are functions of
motor torque and motor
speed.

Model-Based
Calibration Toolbox

“Set Block Parameters” on
page 6-58

Use the optimized current
controller calibration tables for
the Flux-Based PM Controller
block current controller
parameters.

Powertrain Blockset

Collect and Post Process Motor Data
Collect this nonlinear motor flux data from dynamometer testing or finite element analysis
(FEA):

• d- and q- axis current
• d- and q- axis flux linkage
• Electromagnetic motor torque

Use the collected data and motor speed to calculate the d- and q-axis voltages:
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The equations use these variables:
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Vd, Vq d- and q- axis voltage, respectively
id, iq d- and q- axis current, respectively
λd, λq d- and q- axis flux linkage, respectively
RS Stator resistance
ωe Electrical motor angular speed, rad/s
n Motor speed, rpm
P Number of pole pairs

Finally, for each data point, create a file containing:

• d-axis current, Id, in A
• q-axis current, Iq, in A
• Motor speed, n, in rpm
• d-axis voltage, Vd, in V
• q-axis voltage, Vq, in V
• Electromagnetic motor torque, Te, in N.m

For this example, the data file matlab\toolbox\mbc\mbctraining
\ex_motor_data.xlsx contains the motor flux data.

Model Motor Data
To model the motor data, use the MBC Model Fitting app to import, filter, and fit the
data with a one-stage model. For this example, the data file ex_motor_data.xlsx
contains a large data set. You could consider using a design of experiment (DOE) to limit
the data. However, the data set represents typical FEA analysis results.

Import Data

For this example, ex_motor_data.xlsx contains this motor controller data:

• d-axis current, Id, in A
• q-axis current, Iq, in A
• Motor speed, n, in rpm
• d-axis voltage, Vd, in V
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• q-axis voltage, Vq, in V
• Electromagnetic motor torque, Te, in N.m

1 In MATLAB, on the Apps tab, in the Automotive group, click MBC Model Fitting.
2 In the Model Browser home page, click Import Data. Click OK to open a data source

file.
3 Navigate to the matlab\toolbox\mbc\mbctraining folder. Open data file

ex_motor_data.xlsx. The Data Editor opens with your data.
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Filter Data

You can filter data to exclude records from the model fit. In this example, set up a filter to
exclude voltage and current magnitudes that are less than a specified threshold.
Specifically:

• Voltage magnitude, Vs, less than or equal to 300 V.
• Current magnitude, Is, less than or equal to 350 A.

1 In the Data Editor, select Tools > Variables to open the Variable Editor. Create
these variables. Add units.

• Is = sqrt (Id.^2 + Iq.^2)
• Vs = sqrt (Vd.^2 + Vq.^2)

2 In the Data Editor, select Tools > Filters to open the Filter Editor. Create these
filters:

• Is <= 350
• Vs <= 300

Fit Model

Fit the data to a one-stage 5-dimensional model with these responses and inputs:

• Responses

• d-axis voltage, Vd, in V
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• q-axis voltage, Vq, in V
• Inputs

• d-axis current, Id, in A
• q-axis current, Iq, in A
• Motor speed, n, in rpm
• Electromagnetic motor torque, Te, in N.m

1 In the Model Browser, select Fit Models.
2 In Fit Models, configure a One-Stage model with these responses and inputs.

Responses Inputs
Vd

Vq

Id

Iq

Trq

n
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3 To fit the model, select OK. If prompted, accept changes to data. By default, the fit
uses a Gaussian Process Model (GPM) to fit the data.

4 After the fit completes, examine the response models for Vd and Vq. The Model
Browser displays information that you can use to determine the accuracy of the
model fit.

• In the Model Browser, select Vd. Examine the response surface and diagnostic
statistics. In this example, the response surface indicates that Vd increases as Id
approaches 0. The diagnostics indicate that the response residuals are mostly
within ±1 V. These results indicate a reasonably accurate fit.
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5 Save your project. For example, select Files > Save Project. Save gs_example.mat
to work folder.

Generate Calibration
After you fit the model, create functions and tables, run the optimization, and fill the
calibration tables.
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Create Functions

Create the functions to use when you optimize the calibration. In this example, set up
functions for:

• Voltage magnitude, Vs

• Current magnitude, Is

• Torque per amp, TPA

1 In MATLAB, on the Apps tab, in the Automotive group, click MBC Optimization.
2 In the Cage Browser, select Import Models. If it is not already opened, in the MBC

Model Fitting browser, open the gs_example.mat project.

3 In Cage Import tool, select Vd and Vq. Click Import Selected Items.
4 In Import Models, click OK. Close the CAGE Import Tool.
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5 In the Cage Browser toolbar, use New Function Model wizard to create these
functions:

• Is = sqrt (Id.^2 + Iq.^2)
• Vs = sqrt (Vd.^2 + Vq.^2)
• TPA = Trq./Is
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6 In the Cage Browser, verify that the function models for Is, Vs, and TPA have these
descriptions.

7 Select File > Save Project. Save gs_example.cag to the work folder.

Create Tables from Model

Create tables that the Model-Based Calibration Toolbox optimizer uses to store the
optimized parameters. For this example, the tables are:

• d-axis current, Id, as a function of motor torque, Trq, and motor speed, n.
• q-axis current, Iq, as a function of motor torque, Trq, and motor speed, n.

1 In the Cage Browser, select Tables and Tradeoff. In Create Tables from Model,
select Vd. Click Next.
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2 In Table Inputs, set the Table rows to 31. Set Table columns to 29. Click Next.
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3 In Create Tables from Model:

• Select Id and Iq.
• Clear Vd.
• Click Finish.

4 In the CAGE Browser, examine the tables.
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Run Optimization

In this example, run a point optimization with these specifications:

• Voltage magnitude, Vs, less than or equal to 289 V.
• Current magnitude, Is, less than or equal to 300 A.
• Maximizes torque per ampere, TPA.

1 On the Cage Browser home, select Optimization.

2 In Create Optimization from Model, select TPA and Next.
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3 In Create Optimization from Model:

• Select Id and Iq. Clear Trq.
• Set Objective type to Maximize.
• Click Finish.

4 Add a boundary constraint for the Vd model. In the CAGE Browser, select
Optimization > Constraints > Add Constraint. Set these parameters:

• Constraint name: Vd_boundary
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• Input model: Vd
• Evaluate quantity: Boundary constraint

Verify the settings. Click OK.

5 Add the optimization constraints. In the CAGE Browser, select Optimization >
Constraints > Add Constraints to open Edit Constraint. Use the dialog box to
create constraints on the current and voltage.

• Is <= 300
• Vs <= 289
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6 In the CAGE Browser, select Import initial data from a table grid.

In Import From Table Grid, select Id_Table.
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7 In the Cage Browser, carefully verify the Objectives and Constraints.
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8 In the Cage Browser, select Set Up. Set Number of start points to 3. Click Ok.
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9 In the Cage Browser, select Run. The optimization can take time to run and slow
other computer processes. View progress in Running Optimization.

The optimization can take time to run and slow other computer processes. View
progress in Running Optimization.

The optimization results are similar to these.
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Fill Tables

1 In the CAGE Browser, select Fill Tables.

2 Use the Table Filling from Optimization Results Wizard to fill the Id_Table and
Iq_Table tables.
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• For the Id_Table, fill with Id.
• For the Iq_Table, fill with Iq.

Accept the defaults. Click Finish.
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3 Review results for Iq_Table. The results are similar to these.
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4 Review results for Id_Table. The results are similar to these.
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5 Select File > Save Project. Save gs_example.cag to work folder.

Export Results

1 Select File > Export > Calibration > All Items.
2 Use Export Calibration Data to select the items to export and format. For example,

export the Id and Iq tables and breakpoints to MATLAB file gs_example.m.
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Set Block Parameters
The optimized current controller calibration tables are functions of motor torque and
motor speed. Use the tables for these Flux-Based PM Controller block parameters:

• Corresponding d-axis current reference, id_ref
• Corresponding q-axis current reference, iq_ref
• Vector of speed breakpoints, wbp
• Vector of torque breakpoints, tbp

To set the block parameters:
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1 Run the .m file that contains the Model-Based Calibration Toolbox calibration results
for the current controller. For example, in the MATLAB command line, run
gs_example.m:

% Access data from MBC current controller calibration
gs_example

2 Assign the breakpoint parameters to the data contained in the .m file. In this example,
the speed data is in rpm. To use the calibration data for the block parameters,
convert the speed breakpoints from rpm to rad/s.

Parameter MATLAB Commands
Vector of speed breakpoints, wbp tbp=Trq_norm.X;

Vector of speed breakpoints, wbp % MBC data for speed is in rpm.  
% For the block parameter, use rad/s
nbp=n_norm.X;
conversion=(2*pi/60.);
wbp=conversion.*nbp;

Corresponding d-axis current
reference, id_ref

id_table=Id_Table.Z;
id_ref=id_table';

Corresponding q-axis current
reference, iq_ref

iq_table=Iq_Table.Z;
iq_ref=iq_table';
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Generate Feed-Forward Flux Parameters
Using MathWorks tools, you can create lookup tables for an interior permanent magnet
synchronous motor (PMSM) controller that characterizes the d-axis and q-axis flux as a
function of d-axis and q-axis currents.

To generate the flux parameters for the Flux-Based PM Controller block, follow these
workflow steps. The steps use example script VisualizeFluxSurface.m.

Workflow Description
“Step 1: Load and Preprocess Data” on
page 6-60

Load and preprocess this nonlinear motor
flux data from dynamometer testing or
finite element analysis (FEA):

• d- and q- axis current
• d- and q- axis flux
• Electromagnetic motor torque

“Step 2: Generate Evenly Spaced Data” on
page 6-61

Use spline interpolation to generate evenly
spaced data. Visualize the flux surface
plots.

“Step 3: Set Block Parameters” on page 6-
63

Set workspace variables that you can use
for the Flux-Based PM Controller block
parameters.

Step 1: Load and Preprocess Data
Load and preprocess this nonlinear motor flux data from dynamometer testing or finite
element analysis (FEA):

• d- and q- axis current
• d- and q- axis flux
• Electromagnetic motor torque

1 Open the example script VisualizeFluxSurface.m.
2 Load and preprocess the data.

%
% Load the data from a |mat| file captured from a dynamometer or 
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matlab:open('VisualizeFluxSurface.m')


% another CAE tool.
load FEAdata.mat;

% Load the data matrix.
lambda_d = FEAdata.flux.d;
lambda_q = FEAdata.flux.q;
id = FEAdata.current.d;
iq = FEAdata.current.q;

Step 2: Generate Evenly Spaced Data
The flux tables and can have different step sizes for the currents. Evenly spacing the rows
and columns helps improve interpolation accuracy. This script uses spline interpolation.

1 Set the spacing for the table rows and columns.

% Set the spacing for the table rows and columns 
flux_d_size = 50;
flux_q_size = 50;

2 Use spline interpolation to get higher resolution.

% Use spline interpolation to get higher resolution
id_new = linspace(min(id),max(id),flux_d_size);
iq_new = linspace(min(iq),max(iq),flux_q_size);
lambda_d_new = interp2(id',iq,lambda_d,id_new',iq_new,'spline');
lambda_q_new = interp2(id',iq,lambda_q,id_new',iq_new,'spline');

3 Visualize the flux surfaces.

% Visualize the flux surface
figure;
mesh(id_new,iq_new,lambda_d_new);
xlabel('I_d [A]')
ylabel('I_q [A]')
title('\lambda_d'); grid on;

figure;
mesh(id_new,iq_new,lambda_q_new);
xlabel('I_d [A]')
ylabel('I_q [A]')
title('\lambda_q'); grid on;

• d-axis flux, λd, as a function of d-axis current, Id, and q-axis current, Iq.
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• q-axis flux, λq, as a function of d-axis current, Id, and q-axis current, Iq.
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Step 3: Set Block Parameters
Set the block parameters to these values assigned in the example script.

Parameter MATLAB Commands
Vector of d-axis current breakpoints,
id_index

id_index=id_new;

Vector of q-axis current breakpoints,
iq_index

iq_index=iq_new;

Corresponding d-axis flux, lambda_d lambda_d=lambda_d_new;

Corresponding q-axis flux, lambda_q lambda_q=lambda_q_new;
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Generate Parameters for Flux-Based PMSM Block
Using MathWorks tools, you can create lookup tables for an interior permanent magnet
synchronous motor (PMSM) controller that characterizes the d-axis and q-axis current as
a function of d-axis and q-axis flux.

To generate the flux parameters for the Flux-Based PMSM block, follow these workflow
steps. Example script CreatingIdqTable.m calls gridfit to model the current surface
using scattered or semi-scattered flux data.

Workflow Description
“Step 1: Load and Preprocess Data” on
page 6-65

Load and preprocess this nonlinear motor
flux data from dynamometer testing or
finite element analysis (FEA):

• d- and q- axis current
• d- and q- axis flux
• Electromagnetic motor torque

“Step 2: Generate Evenly Spaced Table
Data From Scattered Data” on page 6-67

Use the gridfit function to generate
evenly spaced data. Visualize the flux
surface plots.

“Step 3: Set Block Parameters” on page 6-
69

Set workspace variables that you can use
for the Flux-Based PM Controller block
parameters.

Step 1: Load and Preprocess Data
Load and preprocess this nonlinear motor flux data from dynamometer testing or finite
element analysis (FEA):

• d- and q- axis current
• d- and q- axis flux
• Electromagnetic motor torque

1 Open the example script CreatingIdqTable.m.
2 Load and preprocess the data.
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matlab:open('CreatingIdqTable.m')


% Load the data from a |mat| file captured from a dynamometer or 
% another CAE tool.
load FEAdata.mat;

3 Determine the minimum and maximum flux values.

flux_d_min = min(min(FEAdata.flux.d)) ;
flux_d_max = max(max(FEAdata.flux.d)) ;
flux_q_min = min(min(FEAdata.flux.q)) ;
flux_q_max = max(max(FEAdata.flux.q)) ;

4 Plot the sweeping current points used to collect the data.

for i = 1:length(FEAdata.current.d)
    for j = 1:1:length(FEAdata.current.q)
    plot(FEAdata.current.d(i),FEAdata.current.q(j),'b*');
    hold on
    end
end

5 Plot the current limit sweeping points and circle.

for angle_theta = pi/2:(pi/2/200):(3*pi/2)
    plot(300*cos(angle_theta),300*sin(angle_theta),'r.');
    hold on
end
xlabel('I_d [A]')
ylabel('I_q [A]')
title('Sweeping Points'); grid on;
xlim([-300,0]);
ylim([-300,300]);
hold off
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Step 2: Generate Evenly Spaced Table Data From Scattered
Data
The flux tables and can have different step sizes for the currents. Evenly spacing the rows
and columns helps improve interpolation accuracy. This script uses spline interpolation.

1 Set the spacing for the table rows and columns.

% Set the spacing for the table rows and columns
flux_d_size = 50;
flux_q_size = 50;

2 Generate linear spaced vectors for the breakpoints.
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% Generate linear spaced vectors for the breakpoints
ParamFluxDIndex = linspace(flux_d_min,flux_d_max,flux_d_size);
ParamFluxQIndex = linspace(flux_q_min,flux_q_max,flux_q_size);

3 Create 2-D grid coordinates based on the d-axis and q-axis currents.

% Create 2-D grid coordinates based on the d-axis and q-axis currents 
[id_m,iq_m] = meshgrid(FEAdata.current.d,FEAdata.current.q);

4 Create the table for the d-axis current.

% Create the table for the d-axis current
id_fit = gridfit(FEAdata.flux.d,FEAdata.flux.q,id_m,ParamFluxDIndex,ParamFluxQIndex);
ParamIdLookupTable = id_fit'; 
figure;
surf(ParamFluxDIndex,ParamFluxQIndex,ParamIdLookupTable'); 
xlabel('\lambda_d [v.s]');ylabel('\lambda_q [v.s]');zlabel('id [A]');title('id Table'); grid on;
shading flat;

d-axis current, Id, as a function of q-axis flux, λq, and d-axis flux, λd.
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5 Create the table for the q-axis current.

% Create the table for the q-axis current
iq_fit = gridfit(FEAdata.flux.d,FEAdata.flux.q,iq_m,ParamFluxDIndex,ParamFluxQIndex);
ParamIqLookupTable = iq_fit'; 
figure;
surf(ParamFluxDIndex,ParamFluxQIndex,ParamIqLookupTable');
xlabel('\lambda_d [v.s]');ylabel('\lambda_q [v.s]');zlabel('iq [A]'); title('iq Table'); grid on;
shading flat;

q-axis current, Iq, as a function of q-axis flux, λq, and d-axis flux, λd.

Step 3: Set Block Parameters
Set the block parameters to these values assigned in the example script.
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Parameter MATLAB Commands
Vector of d-axis flux, flux_d flux_d=ParamFluxDIndex;

Vector of q-axis flux, flux_q flux_q=ParamFluxQIndex;

Corresponding d-axis current, id id=ParamIdLookupTable;

Corresponding q-axis current, iq iq=ParamIqLookupTable;
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